Voice Logging Recorder

19" Rack Mount — 4 to 32 channels
Desktop — 4 to 16 channels

User Manual

For use with Total Recall recorders running software V4.56,
Remote Manager software V1.56, and Record On Demand software V1.56

V4.56-USA, Revision 4
Table of Contents

1. COMPLIANCE STATEMENT ........................................................................................................ 5
2. SAFETY INFORMATION ........................................................................................................ 7
3. INTRODUCTION .................................................................................................................. 8
   3.1 Total Recall Models ........................................................................................................ 8
   3.2 Total Recall Options ...................................................................................................... 8
      3.2.1 Channel Upgrades ............................................................................................... 8
      3.2.2 Dual Hot Swap Power Supply ............................................................................ 9
      3.2.3 Archiving Options ............................................................................................. 9
   3.3 Unpacking ...................................................................................................................... 9
   3.4 Getting Started ............................................................................................................. 9
   3.5 Total Recall Features .................................................................................................. 10
4. QUICK START-UP GUIDE .................................................................................................... 10
5. GETTING TO KNOW TOTAL RECALL ............................................................................. 11
   5.1 Total Recall Front Panel .............................................................................................. 11
      5.1.1 Headphone Jack ............................................................................................... 11
      5.1.2 Line Output Jack .............................................................................................. 11
      5.1.3 Volume Control ............................................................................................... 11
      5.1.4 CD/DVD Writer ............................................................................................... 11
      5.1.5 Speaker Grill .................................................................................................... 12
      5.1.6 Cooling Fan Vent ............................................................................................ 12
      5.1.7 Front Panel On/Off Switch (Rack Mount Model Only) .................................. 12
   5.2 Recorder Rear Panel .................................................................................................... 12
      5.2.1 Remote Connection Ports – Network (LAN) and Dial-up (Modem) .............. 12
      5.2.2 Line Interface Connectors ................................................................................ 12
      5.2.3 Power Cable Socket ......................................................................................... 12
      5.2.4 On/Off Switch .................................................................................................. 13
      5.2.5 Fuse (Desktop Model only) .............................................................................. 13
      5.2.6 Power Supply — Desktop Model ...................................................................... 13
      5.2.7 Power Supply — Rack Mount Model .................................................................. 13
   5.3 Control Panel ................................................................................................................ 13
      5.3.1 LCD Display ...................................................................................................... 13
      5.3.2 MENU Key ........................................................................................................ 13
      5.3.3 SELECT Key ..................................................................................................... 13
      5.3.4 UP and DOWN Scroll Keys .............................................................................. 13
      5.3.5 Power & Hard Drive Activity LEDs ................................................................. 14
      5.3.6 Numeric Keypad ............................................................................................... 14
      5.3.7 Playback Control Keys ...................................................................................... 14
6. INSTALLING TOTAL RECALL ......................................................................................... 14
   6.1 Signal Sources .............................................................................................................. 14
   6.2 DSP Card Identification .............................................................................................. 14
   6.3 Connecting to the Telephone Network to Record Conversations .............................. 15
   6.4 Location of the Recorder ............................................................................................. 15
   6.5 Connecting to Analog Phone Lines ............................................................................... 15
   6.6 Connecting to a Digital Phone Using Phone Handset/Headset Adapters ................... 16
   6.7 Connecting to a Digital Extension Line ........................................................................ 17
   6.8 Caller Line Interface (CLI / Caller ID) & Touch Tone (DTMF) Capture .................... 18
7. SWITCHING ON AND GETTING STARTED ..................................................................... 18
   7.1 General ......................................................................................................................... 18
   7.2 Main Menus .................................................................................................................. 18
8. CONFIGURING TOTAL RECALL ................................................................. 22
  8.1 Channel Settings ....................................................................................... 23
     8.1.1 Trigger ................................................................................................. 23
     8.1.2 Monitor .................................................................................................. 23
     8.1.3 Beep ....................................................................................................... 24
     8.1.4 ROD Mode (*Record On Demand) ......................................................... 24
     8.1.5 Allow ROD Phone Key .......................................................................... 24
  8.2 Passwords .................................................................................................. 25
     8.2.1 User Password ....................................................................................... 25
     8.2.2 Administrator Password ....................................................................... 25
     8.2.3 Entering a Password ............................................................................. 25
     8.2.4 Changing a Password .......................................................................... 26
  8.3 Call Settings ............................................................................................... 26
     8.3.1 Minimum Call Length ........................................................................... 26
     8.3.2 Maximum Call Length .......................................................................... 27
     8.3.3 VOX Timeout ......................................................................................... 27
     8.3.4 Recording Period .................................................................................. 27
  8.4 Remote Access Settings ............................................................................. 28
  8.5 Network Settings ....................................................................................... 28
     8.5.1 Connecting Total Recall Using LAN ....................................................... 28
     8.5.2 Entering IP Address .............................................................................. 29
  8.6 Dial-up ........................................................................................................ 29
     8.6.1 Modem .................................................................................................... 29
     8.6.2 Dial-up Address ..................................................................................... 29
     8.6.3 Cascading .............................................................................................. 29
     8.6.4 DHCP (Dynamic Host Configuration Protocol) .................................... 29
  8.7 Maximum Sessions .................................................................................... 29
  8.8 Session Duration ....................................................................................... 30
  8.9 RMI Port ..................................................................................................... 30
  8.10 Language .................................................................................................. 30
  8.11 Time & Date ............................................................................................ 30
  8.12 Upgrade Software .................................................................................... 31
  8.13 Recorder ID .............................................................................................. 31
  8.14 Rebuild Call Database .............................................................................. 32
  8.15 Save and Load Settings from DVD or CD ................................................ 32
  8.16 Erase DVD ............................................................................................... 32

9. OPERATING TOTAL RECALL .................................................................... 32
  9.1 Searching for Calls .................................................................................... 32
     9.1.1 Searching from the Hard Drive ............................................................... 32
     9.1.2 Searching from the DVD or CD Archive (Using Total Recall) .......... 33
  9.2 Replaying Calls ........................................................................................ 34
     9.2.1 From Search Menu .............................................................................. 34
     9.2.2 From Logging Menu ............................................................................ 34
  9.3 Live Monitoring of Calls .......................................................................... 34
  9.4 Archiving Calls ........................................................................................ 35
     9.4.1 Archive Sessions .................................................................................. 35
     9.4.2 Tagging (*) a Call ................................................................................ 35
10.19 Handling Multiple Remote Managers Behind a Local Firewall ........................................54
10.20 Connecting Through a VPN ..........................................................................................55
10.21 Limitations of Total Recall & Remote Manager with Firewalls ...............................55
   10.21.1 Transfer of Files .................................................................................................55
10.21.2 Alternatives .........................................................................................................55
10.22 Monitoring & Playback — Audio not Working .........................................................56

11. RECORD ON DEMAND SOFTWARE (ROD) ...............................................................60
   11.1 Introduction ...............................................................................................................60
   11.2 PC Requirements ....................................................................................................60
   11.3 Installation ...............................................................................................................60
   11.4 Running TR ROD for the First Time .................................................................60
       11.4.1 Connecting to the Total Recall Unit ............................................................60
       11.4.2 Logging into TR ROD .....................................................................................61
   11.5 Using TR ROD — TR Unit Settings .......................................................................61
       11.5.1 Record by Default ..........................................................................................61
       11.5.2 Don’t Record by Default ..............................................................................61
       11.5.3 Add Notes Only ...........................................................................................61
       11.5.4 Record Partial Calls .....................................................................................61
       11.5.5 Disallowed ....................................................................................................62
   11.6 Login, Logout and Refresh .......................................................................................62
       11.6.1 Configuration .................................................................................................62

12. PREVENTATIVE MAINTENANCE ..............................................................................62
13. TROUBLE-SHOOTING TIPS ......................................................................................63
14. SPECIFICATIONS ........................................................................................................65
15. APPENDIX A, GLOSSARY OF TERMS .................................................................66
16. APPENDIX B, LCD SCREEN MESSAGES .................................................................66
17. SOFTWARE LICENSE AGREEMENT .......................................................................67
1. Compliance Statement

**European Model**

The equipment has been approved in accordance with Council Decision 98/482/EC for pan-European single terminal connection to the public switched telephone network (PSTN). However, due to differences between the individual PSTNs provided in different countries, the approval does not, of itself, give an unconditional assurance of successful operation on every PSTN network termination point.

In the event of problems, you should contact your equipment supplier in the first instance.

This device is designed to work on any network. This device is not dependent on physical and software switch settings. If this device is to be used outside of your area or different network, contact your vendor.

This device complies with Class A of EN55022: 1995 incl. Amendments 1 & 2.

**Warning**

This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.

**New Zealand Model**

This device complies with Class A of AS/NZS3548:1995, incl. Amendments 1 & 2.

**Warning**

This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.

8.1.8 Call logging (automatic set-up).

(b) “The call log incorporated in this equipment does not record all answered calls. The call log, therefore, may not agree with the Telecom account which may include calls not shown on the log.”

8.5 Recording functions.

(c) “All persons using this device for recording telephone conversations shall comply with New Zealand law. This requires that at least one party to the conversation is to be aware that it is being recorded. In addition, the Principles enumerated in the Privacy Act 1993 shall be complied with in respect to the nature of the personal information collected, the purpose for its collection, how it is used and what is disclosed to any other party.”

**USA Model**

**FCC Rules, Part 15**

*Total Recall* has been tested and complies with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, can cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user will be required to correct the interference at the user’s expense.
1. **FCC Part 68 Registration**

*Total Recall* complies with FCC Rules, Part 68. On this equipment is a label that contains, among other information, the FCC Part 68 registration number.

2. **REN**

The ringer equivalence number (REN) is used to determine the quality of devices, which may be connected to the telephone line. Excessive RENs on the telephone line may result in the devices not ringing in response to an incoming call. In most, but not all, areas the sum of RENs should not exceed five (5.0). To be certain of the number of devices that may be connected to a line, as determined by the total RENs, contact the local telephone company.

NOTE: RENs are associated with loop-start and ground-start ports. It is not used for E&M and digital ports. The REN assigned to *Total Recall* is 1.5B. If requested, this information must be given to the telephone company.

3. **Service**

In the event of equipment malfunction, all repairs should be performed by *Arunta Comsec Pty Ltd* or an authorized agent. It is the responsibility of users requiring service to report the need for service to *Arunta Comsec Pty Ltd* or to one of our authorized agents. Service can be facilitated through our office at:

- **Arunta Comsec Pty Ltd**
  - Unit 5, 7 Millennium Court
  - Silverwater, NSW 2128
  - Australia
  - Email: totalrecall@totalrecallvr.com

- **Omnicon Electronics**
  - 581 Liberty Highway
  - Putnam, CT 06260 USA
  - Phone: (860) 928-0377, Fax: (860) 928-6477
  - Email: service@omnicronelectronics.com

The telephone company can ask you to disconnect the equipment from the network until the problem is corrected or until you are sure that the equipment is not malfunctioning.

4. **Facility Interface Information**

In order to connect registered terminal equipment to the telephone company lines, the terminal equipment must utilize an FCC registered jack. Standardized jacks are used for this equipment. The following table contains Facility Interface Code (FIC), Ringer Equivalence Number (REN), Service Order Code (SOC) and network jack information for the equipment.

<table>
<thead>
<tr>
<th>Port Identifier</th>
<th>FIC</th>
<th>REN</th>
<th>Network Jack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line 1 to Line 32</td>
<td>Not Applicable</td>
<td>1.5B</td>
<td>RJ11C</td>
</tr>
</tbody>
</table>

The *Total Recall* interface connects to the Public Switched Telephone Network through a FCC registered NCTE that specifies the type of network jack to be used.

5. **Disruption of the Network**

If the *Total Recall* disrupts the telephone network, the telephone company can discontinue your service temporarily. If possible, the telephone company will notify you in advance. If advance notice is
not practical, they will notify you as soon as possible. You are also informed of your right to file a complaint with the FCC.

6. **Telephone Company Facility Changes**

   The telephone company can make changes in its facilities, equipment, operations, or procedures that can affect the operation of your equipment. If they do, you should be notified in advance so you have an opportunity to maintain uninterrupted telephone service.

7. **Electrical Safety Advisory**

   While *Total Recall* is fully compliant with FCC rules and regulations, it is recommended that an alternating current (AC) surge arrester of the form and capability suitable for the model purchased be installed in the AC outlet to which the *Arunta Comsec Pty Ltd* products are connected. Consult with your distributor as to the surge protector requirements for your equipment.

   **Notes:**
   
   a) If a ruling is required on the legality of recording in your country, please seek legal advice.
   b) This product must not be used for illegal or unauthorized recording purposes.

---

2. **Safety Information**

**WARNING!**

*Potential Shock Hazard*

   Always follow basic safety precautions when using this product to reduce the risk of injury from fire or electrical shock.

   a) Read and understand all instructions in the user manual.
   b) Observe all warnings and instructions marked on the product.
   c) Use only a grounded electrical outlet when connecting *Total Recall* to a power source. If you are unsure the outlet is grounded have a qualified electrician check this.
   d) Do not touch the contacts on the ends of any of the cables used with *Total Recall*. If any cable becomes damaged have it repaired immediately.
   e) Shut down and unplug *Total Recall* from power outlets and telephone jacks prior to cleaning.
   f) Do not open *Total Recall*. There are no user serviceable parts inside *Total Recall*.
   g) Refer all servicing to qualified personnel.
3. Introduction

_Total Recall_ is a compact, cost-effective and self-contained digital Voice Logger / Recorder that records and provides secure storage for over 10,000 hours of calls. Call information is presented on the color TFT Liquid Crystal Display (LCD). With simple keystrokes and three easy to navigate menus, _Total Recall_ is easy to configure and operate. The user configures and operates _Total Recall_ to search, playback and archive calls. Using LAN or Dialup you will have remote access to _Total Recall_ over your network or phone line using _Remote Manager_; _Record on Demand_ may be optionally installed to give users limited control over what is recorded on their line.

Available as a 4, 8, 12 or 16 channel Desktop unit or 4, 8, 12, 16, 20, 24, 28, or 32 channel 19” Rack Mount unit, _Total Recall_ will record the telephone numbers of incoming* and outgoing calls**, and store this information in a database, together with a time & date stamp, the duration of the call and reference to the specific channel number. All these “fields” can be used to search and retrieve calls from the database.

Once a call has been located and retrieved from the _Total Recall_ database, the call can be replayed via an internal or external speaker, or, for privacy, via a headphone port.

*Note: Functions only if Caller ID (Caller Line Identification / CLI) is available on the line at the connection point.

**Note: Functions only if DTMF tones are present on the line at the connection point.

This User Manual covers operational aspects of your _Total Recall_ Voice Logger / Recorder operating as a stand-alone unit or as a networked device. Throughout this manual, actual screen displays are used to illustrate the operation being described. Section 4 contains a quick Start-up Guide for those users who would prefer to start in the minimum time. We recommend that you keep this manual at a location near the unit for quick reference. Your _Total Recall_ supplier is available to assist you with all other technical and installation matters.

3.1 Total Recall Models

- TRL-04     4-channels, Desktop
- TRL-08     8-channels, Desktop
- TRL-12     12-channels, Desktop
- TRR-04     4-channels, Rack Mount
- TRR-08     8-channels, Rack Mount
- TRR-12     12-channels, Rack Mount
- TRR-16     16-channels, Desktop
- TRR-20     20-channels, Rack Mount
- TRR-24     24-channels, Rack Mount
- TRR-28     28-channels, Rack Mount
- TRR-32     32-channels, Rack Mount

All _Total Recall_ models are supplied with _Remote Manager_, the client software for _Total Recall_, and _Record on Demand_, a limited control program designed for non-administrative users. Both are Windows based 95/98/NT/2000/ME/XP programs.

_Remote Manager_ is used to search and replay calls from either an archive DVD or CD, if there is no requirement to use the LAN or Dial-up functionality, or enables full remote access to _Total Recall_ via the LAN or Dial-up interface. Calls can be selected and transmitted via e-mail for replay on a multimedia PC at a remote location.

3.2 Total Recall Options

3.2.1 Channel Upgrades

Each _Total Recall_ Desktop unit can accommodate up to 2 DSP (Digital Signal Processor) cards and the Rack Mount unit up to 4 DSP cards. Both units can be upgraded with 4 channel and/or 8 channel cards. See your supplier for further information. Ordering details:

- TR-U4     4-channel upgrade card
- TR-U8     8-channel upgrade card
3.2.2 Dual Hot Swap Power Supply

*Total Recall* Rack Mount models come supplied with a standard ATX PC type power supply. A dual hot swap power supply is available for the rack mount models only. Contact your *Total Recall* supplier for details.

3.2.3 Archiving Options

*Total Recall* is supplied with a CD/DVD drive used to record on CD-R and DVD+RW media only.

3.3 Unpacking

*Total Recall* recorders distributed by Omnicron Electronics are supplied with the following items:

- *Total Recall* Voice Logger/Recorder (either desktop or rack mount configuration).
- Remote Manager CD (contains PC client software – provides full access).
- Record on Demand CD (contains PC client software – provides limited access).
- Power cable.
- 2 blank CD-R and 1 blank DVD+RW.
- Two copies of this User Manual.
- Quick Start-up Guide.
- A Yellow crossover cable to connect to a PC.
- A modem cable to connect from *Total Recall* to a serial modem.
- One 18' RJ11 to RJ11 phone line input cable with “T” adapter for each input jack.

Other adapters and cables, such as the Omnicron TSA-3LM handset connection adapters, may have been purchased along with your *Total Recall* recorder. Contact your *Total Recall* dealer if special cables or adapters are required. Rack Mount recorders also include keys for their front panel power ON/OFF switch and rack mount mounting hardware.

If cables have to be run, and if connection is required to the MDF or distribution frame, it is advisable to request a certified telecom engineer to install the telephone cabling required for the recorder.

*Note: DO NOT* load the Remote Manager CD or Record On Demand CD into the *Total Recall* CD/DVD drive. The Remote Manager and Record on Demand CDs are only for use in Windows PCs.

**Important Note:** To ensure no loss of power or interruption to recordings, it is strongly recommended that *Total Recall* be connected to a UPS power system (Maximum power consumption for 16 channel TRL-16 is 50 Watts). *Total Recall* utilizes a database with potentially open and active files. Power disruption with an unclean shut down may cause damage to these files and may require a database rebuild. This rebuild will occur automatically when power returns.

3.4 Getting Started

Having completed the installation of *Total Recall* by following the instructions in Section 6, you may commence using *Total Recall* immediately by following the simple instructions in the Quick Start-up Guide, Section 4.

For a more complete understanding of the comprehensive features of *Total Recall*, we recommend that you read through the remainder of this manual.
3.5 Total Recall Features

Total Recall - Voice Logger/Recorder – Rack Mount & Desktop Versions

Total Recall Voice Logger/Recorder has the following features:

- It has been specially designed to record telephone conversations, or any analog audio signal.
- It records digitally (records direct to a hard disk in compressed file format).
- It starts and stops recording by VOX or Off-Hook activation.
- It archives the recordings to DVD or CD to provide a permanent backup record.
- It has a high compression factor, resulting in a large storage capacity.
- It has a facility to live monitor calls either locally or remotely.
- All channels can be configured and managed selectively or as a group.
- It is compact, self-contained, and easy to install and operate.
- LAN & Dial-up connectivity is built-in.

4. Quick Start-up Guide

- Check the contents of the Total Recall package (refer to Section 3.3-Unpacking). Ensure your recording connections are in place.
- Connect the Total Recall recorder to the input line(s), and connect the power cord.
- Turn on the power with the switch at the rear panel.
  Note 1: The internal power supply of the Desktop unit is auto sensing (90VAC to 260VAC).
  Note 2: The internal power supply of the Rack Mount unit is 110VAC to 250VAC.
- Wait approximately 3 minutes for Total Recall to complete its start-up.
- Default Passwords are 0000 (Administrator and User).
- Go to the Options Menu by pressing the <MENU> key twice.
- Select General Settings by pressing <SELECT>.
  Set Language, Time, Date, & Time Zone (call database must be empty to change Time Zone), and Password (if you wish to change the default password) by using the <UP> <DOWN> arrow keys and <SELECT> to enter the Menu of choice. Press the <OK> or <CANCEL> key to return to the General Settings Menu.
- Select Line Settings.
  Set desired “Line” Trigger, “Mon” (Monitor) and “Beep” settings by pressing the <DOWN> arrow key to highlight Line 1 and then pressing <SELECT>.
- Select Apply to confirm.
- Press the <OK> or <CANCEL> key to return to the Options Menu.
- If you will be connecting the recorder to a network (LAN), select Network Settings and then set the unique Network Address and Subnet Mask. Press <OK>.
- Use one of the phone lines connected to the recorder and make a test call.
- Check that the call appears on the Logging Menu, showing “C” in the status column.
- When the conversation is finished, enter the password if required, position the cursor over the call and press the <SELECT> button to replay the call. Adjust the speaker volume using the thumb wheel on the front panel.
5. Getting to Know Total Recall

Total Recall is very simple to operate, and has a minimum number of ports and key controls. Everything that is needed to operate Total Recall is included with the unit. It is not necessary to attach a PC/monitor as a management console for the recorder.

**Top View**, showing main control/connection points on Desktop Unit

- **Network & Modem Connection**
- **4 to 16 Channel Line Input**
- **TFT LCD**
- **Panel & Select Keys**
- **Headphone Jack**
- **Line Output Jack**
- **Volume Control**
- **Archive CD-R or DVD Drive**
- **Up/Down Scroll Keys**

**Front View**, showing main control/connection points on 19" Rack Mount Unit

- **Network & Modem Connection**
- **4 to 32 channel Line Inputs**
- **TFT LCD**
- **Control Keypad**
- **Press & lift front panel**
- **Headphone Jack**
- **Line-out Jack**
- **Volume**
- **Hard Disk Activity LED**
- **Menu & Select Key**

5.1 Total Recall Front Panel

5.1.1 Headphone Jack
Standard 3.5mm audio jack for connection of headphones or external speaker, volume controlled.

5.1.2 Line Output Jack
Standard 3.5mm audio jack for connection to a tape recorder or the line input of a PC. The line level audio at this jack is pre-set. This output is not controlled by the recorder’s volume control.

5.1.3 Volume Control
Thumb wheel to adjust internal speaker and headphone jack volume.

5.1.4 DVD/CD Writer
Standard front panel controls for a Read/Write DVD/CD drive.
5.1.5 Speaker Grill
Left-hand side of case viewed from the front on Desktop Unit. Top left of front panel on Rack Mount Unit.

5.1.6 Cooling Fan Vent
Front underside of case on Desktop Unit. Top left center of front panel on Rack Mount Unit.

5.1.7 Front Panel On/Off Switch (Rack Mount Model Only)
There is Key Switch is located on the left side of the front panel of the Rack Mount model. This is used to restart the unit after a Software Upgrade. When the unit is mounted in a 19" rack, the ON/Off Switch that is located at the rear of the unit on the Power Supply may not be accessible.

*Note:* It is recommended that the ON/OFF Switch Key is not left in the switch to prevent accidental powering OFF the unit.

5.2 Recorder Rear Panel

5.2.1 Remote Connection Ports – Network (LAN) and Dial-up (Modem)
One port for network connection and one port used for connection to an RS232 modem. These sockets are standard RJ45 sockets (8P8C).

5.2.2 Line Interface Connectors
*Total Recall* has 4, 8, 12 or 16 channels for the Desktop Unit and 4, 8, 12, 16, 20, 24, 28 or 32 channels for the Rack Mount Unit. The connectors for the telephone line interface are standard RJ11C/RJ12/RJ14. The black jacks on four channel DSP cards have one input on each jack (6P4C or 6P6C). The gray jacks on eight channel DSP cards have two channels on each jack (see section 6.2).

5.2.3 Power Cable Socket
IEC 90VAC - 260VAC power cable socket.
5.2.4 On/Off Switch
Switches Total Recall On or Off.

5.2.5 Fuse (Desktop Model only)
240VAC 1.0 - 1.25 ampere anti-surge fuse.

5.2.6 Power Supply — Desktop
Total Recall desktop unit comes with an auto sensing power supply 90VAC - 260VAC, 50Hz - 75Hz, power consumption is 50 watts maximum.

5.2.7 Power Supply — Rack Mount
Total Recall 19" Rack Mount is available with 2 power supply options.

1: Standard PC power supply auto sensing 90VAC - 260VAC, 50Hz - 60Hz 250 watts.

2: Dual Hot Swap power supply 110VAC switchable to 240VAC, 50Hz - 60Hz, 300 watts total.

5.3 Control Panel

5.3.1 LCD Display
The color TFT LCD displays the various screen menus. After 5 minutes of keypad inactivity, the LCD backlight will automatically turn off to extend the life of the backlight. However, the recorder will continue to function normally.

5.3.2 MENU Key
The <MENU> key is used to navigate between the three main menus, Logging, Search, and Options. When <MENU> is pressed with the cursor at the top of one of the three main menus, the cursor moves to the top of the next main menu. The system will “beep” each time the <MENU> key is pressed.

When <MENU> is pressed and the cursor is in the body of a main menu, the cursor will go straight to either the OK or Cancel button saving keystrokes.

5.3.3 SELECT Key
Use the <SELECT> key to start an operation associated with a highlighted button or item, and to confirm a request.

5.3.4 UP and DOWN Scroll Keys
The <UP> <DOWN> arrow keys are used to navigate within a menu. With each <UP> or <DOWN> key press, the cursor highlights a different button or item within the menu. As you press the <UP> <DOWN> arrow keys, the system will “beep”.

Use the <DOWN> key to highlight items across the screen from left to right as well as down. You can use the <UP> arrow key to move in the reverse direction.
5.3.5 Power & Hard Drive Activity LEDs
GREEN is the “Power On” indicator.
RED shows activity of the Hard Disk Drive (HDD).
After 5 minutes of keypad inactivity, the LCD backlight will automatically turn off but the recorder will continue to function normally. When in this state, the green Power LED will flash continuously every 2 seconds. Pressing any key will illuminate the LCD backlight and the Power LED will stop flashing.

5.3.6 Numeric Keypad
Standard keypad, including 0-9, *, and #.

5.3.7 Playback Control Keys
During the playing of a call, the “Control Keys” can be used to navigate through the call. The “Control Keys” operate in the same way as the keys on a CD or tape player. They can be used to Stop, Play, Fast Forward and Fast Rewind through a call. Pressing the “Play” key during playback will cause the playback to Pause. Pressing the “Play” key again will continue playing the call.

Pressing the “Stop” key (Playback “Control Keys”) when you’re not playing a call locks the User Interface (the padlock icon on the LCD ‘closes’) when in the Options, Logging and Search Menus. This negates the normal 120-second timeout required for the User Interface to lock.

6. Installing Total Recall

6.1 Signal Sources
Total Recall requires 2-wire analog inputs. A digital line signal will first need to be converted to analog before being recorded.

Total Recall can be installed to record from any one of six possible signal sources:
- An analog trunk (exchange) line.
- An analog extension line.
- A telephone handset, either analog or digital (via handset splitter/logger patch).
- A digital extension line, using D/A converters.
- A digital trunk line, using D/A converters.
- A radio or other audio signal presented as a two-wire analog interface.

Various standard and special order cables and/or adapters are available from your Total Recall representative. If you require a different cable or adapter than was supplied with your unit, contact your representative for assistance.

6.2 DSP Card Identification
Total Recall desktop units have either 4 or 8 RJ11C/RJ12/RJ14 (6P6C) modular line interface jacks. Rack mount units could have as many as 16 dual line jacks for a maximum of 32 channels. The 8-channel DSP card has gray color four-way RJ11C/RJ12/RJ14 connectors. The 4-channel DSP card has black color four-way RJ11C/RJ12 connectors. The black two-wire interface jacks use pins 3+4 (the center pair) of the RJ11C/RJ12 connector. The gray four-wire interface uses pins 3+4 and pins 2+5 of the RJ11C/RJ12/RJ14 connector.
6.3 Connecting to the Telephone Network to Record Conversations
The location of the recorder, in a communications room or office area, will depend on issues such as user access, security access, telephone wiring and available space.

The *Total Recall* line interface is two-wire analog. The connector terminations on the rear panel of the recorder are standard RJ11C/RJ12/RJ14 (6P6C) sockets.

The line interface on the recorder is a terminating point and not a pass-through point and, therefore, it is not possible to connect the recorder in series with a telephone handset. The line interface connection from the recorder must be run back to a termination point. This termination point is normally a parallel tap to an extension line, a trunk line or a handset on an analog or digital telephone, depending on the application.

Most PABX/PBX installations have an MDF or distribution frame fitted between the incoming trunk lines and the premise equipment. The trunk lines are terminated to the MDF, and then connected through to the PABX. Similarly, there is normally a distribution frame on the extension (office) side of the PABX. From this frame, the telephone cabling is routed through the office/work area to individual telephones, or telephone connection points.

6.4 Location of the Recorder
The recorder can be located near the PABX and distribution frame, or near the designated user(s) in the office area. Care should be taken when planning the installation to ensure that telephone cable runs and ease of access to the recorder are considered. The area should be dust free and the room temperature should be kept down to an acceptable level.

6.5 Connecting to Analog Trunk or Analog Extension Lines
*Total Recall* can be connected to the trunk side or the extension side of the PABX, depending on user preferences and operational requirements.

The main difference is that an extension side connection will enable the recording of internal (extension to extension) calls. In this case, the extension number dialed may be recorded as a search field, provided the handset generates a DTMF dialing tone.

If the number of extensions exceeds the number of trunks, and the requirement is only to record external calls and not internal office calls, then the recorder can be connected to the MDF or distribution frame on the trunk side.

Connecting on the trunk side will permit Caller-ID capture if Caller-ID is activated.
In this example (page 15), the recorder is patched onto an analog distribution strip within the communications or PABX room. Only three of the five available extensions will be recorded. If required, the recorder could be located out in the office area and wired back to the distribution frame.

6.6 Connecting to a Digital Phone using Telephone Adapters/Logger Patches

Many PABX/extension installations are digital. It is common to have digital signaling on the extension side, with analog or digital trunk lines installed.

It is important to know the configuration of your PABX system before installing a voice logger. Total Recall will not record a digital line signal directly into the recorder, so digital to analog conversion must be done prior to connecting to the recorder. You can use the D/A converter that is built into digital phones by tapping the analog audio at the handset/headset connection with a handset adapter.

**Note:** Total Recall does not provide D/A conversion. If needed, a third party product would be required for this function.

Unlike standard two-wire analog telephone circuits, most digital PABXs generate their own signaling protocol, and therefore recording from digital lines or handsets can be different for each application.

Most digital handsets have audio signaling in the handset, with the speaker (earpiece) and microphone (mouthpiece) channels being connected to the recorder. A “Handset Adapter” can be used to parallel tap the audio signal from a telephone handset. The audio output from the “Handset Adapter” connects to one of the audio inputs on the recorder. It is possible to find a signal level difference between the speaker and microphone and therefore, in a recorded conversation, one party may be heard more clearly than the other. (This is a limitation of recording via handset adapters and not a recorder limitation.)

Combinations of PABX and digital handsets can produce variable signal levels.

**Note:** It is not possible to capture incoming call data (Caller Line Identification – Caller ID) on the recorder when using handset adapters, as the recorder connection is to the handset rather than to the
incoming line. With some handsets, standard DTMF signaling tones are not transmitted and thus will not be captured by the recorder.

Handset adapters/logger patches are available from your supplier (such as Omnicron item # TSA-3LM, TSA-SLM, etc). Your supplier should be able to advise on a suitable handset adapter that is compatible with the line signaling and wiring of your telephone handset.

The diagram below shows a “representation” of how handset adapters may be used to enable recording direct from digital handsets.

Rack Mount Total Recall is shown above. Connections are the same for a Desktop Total Recall.

6.7 Connecting to a Digital Extension Line
It is possible to connect (tap) directly to a digital extension line by using a Digital to Analog (D/A) converter.

D/A converters are normally switch and protocol-specific, often using PABX protocol-specific interface cards in a rack mount configuration, with 1 or 2 connections per line card.

A D/A converter will monitor activity on the line, and reformat the digitized information on the line into a standard analog format required by most recorders. The D/A converter will passively capture both sides of a conversation and send the audio signal to the recorder only when a conversation is present.

Some D/A converters will capture CLI information provided it is available on the line at the point of connection. D/A converters need to be installed in the Communications/PABX room, in close proximity to the PABX. There is normally a distance limitation between the D/A converter and the recorder. As with handset/headset adapters, D/A converters are generally available from the supplier of your telephone system.

Note: Total Recall does not provide this D/A conversion facility.
6.8 Caller Line Interface (CLI / Caller ID) & Touch Tone (DTMF) Capture

For extension side recording, each phone set is dedicated to a specific channel, and will always record the same channel unless the line is disconnected or physically changed to another port.

For trunk side recording, the next call in or out will generally pick up the next available channel on the recorder, so agent calls are not channel specific.

If the recorder is connected trunk side on an analog line and set to VOX activation, and an operator/receptionist answers the incoming call, the recorder will record the operator’s comments, and also the continuing conversation of the call if it is transferred. However, in this scenario, the recorder will not capture the agent’s extension number.

The CLI (Caller ID) data will only be captured if it is embedded in the incoming call data. The recorder is designed to detect DTMF tones on dialing and display the “Dialed Number” in the Number Field of the call record. If DTMF is not present at the point of recording, the DTMF number will not be displayed.

*Note:* Due to differences in the International Standards for CLI and Off-Hook, CLI captured for an unanswered call will be held for 5 seconds after the last ring detect and if a new call comes in without CLI within that 5-second period the previous CLI may be displayed. If CLI is critical, it is suggested that VOX trigger settings are used.

7. Switching On and Getting Started

7.1 General

Once the line interface and network cables have been connected, connect the power cable and switch ON the recorder. The power ON/OFF switch is located next to the power connector at the rear of the unit.

Initially, you will see the green power LED illuminate. The red LED will flash to show HDD activity and you will hear a short beep. Text will begin scrolling on the LCD screen and then the *Total Recall* logo will be displayed. A screen will then appear giving you essential recorder information and a few seconds later the *Logging Menu* will be displayed with the padlock icon “locked”. This Menu is the “default” Menu that the system will revert to after 120 seconds of inactivity.

Before commencing to navigate the menu structure, enter the password [default 0000] at the *Logging Menu* and then press <SELECT>. The padlock icon in the top right corner of the LCD displays “unlocked”.

7.2 Main Menus

There are three main menus: *Logging, Search,* and *Options*.

7.2.1 Menu Site Map

*Logging Menu*

*Search Menu*

Search

Date

Time

Number

Search DVD or CD

Search

Tag All

Untag All

Archive

Archive Calls

All Calls

Found Calls

Unarchived Calls

Tagged Calls

Archive Device
Options Menu

General Settings

Language
- English
- Spanish
- Portuguese
- Korean
- Chinese
- Japanese
- Arabic (Islamic)
- Arabic (Gregorian)

Time and Date
- Date
- Time
- Time Zone Area
- Time Zone City

User Password
Administrator Password

Channel Settings
- Channel
- Trigger
- Monitor
- Beep
- ROD Mode
- Allow ROD Phone Key

Archive Settings
- Reminder
- Auto Archive
- Archive Device

Call Settings
- Min Call Length
- Max Call Length
- VOX Timeout
- Recording Period

Network Settings
- Use Dial-up
- Use DHCP
- IP Address
- Netmask
- Gateway
- Host Name
- Max. Sessions
- Session Duration
- Port Base
- LAN ID
- Advanced
- Heartbeat

Maintenance
- System Information
- Rebuild Call Database
- Load Settings from CD
- Save Settings to CD
- Erase DVD

System Shutdown
- Confirm
7.2.2 Default Settings

<table>
<thead>
<tr>
<th>Total Recall Default Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Settings</strong></td>
</tr>
<tr>
<td>Language</td>
</tr>
<tr>
<td>Admin Password</td>
</tr>
<tr>
<td>User Password</td>
</tr>
<tr>
<td><strong>Archive Settings</strong></td>
</tr>
<tr>
<td>Reminder</td>
</tr>
<tr>
<td>Auto Archive Every</td>
</tr>
<tr>
<td>Archive Device</td>
</tr>
<tr>
<td>Next Archive</td>
</tr>
<tr>
<td><strong>Call Settings</strong></td>
</tr>
<tr>
<td>Max. Call Length</td>
</tr>
<tr>
<td>Min. Call Length</td>
</tr>
<tr>
<td>VOX Timeout</td>
</tr>
<tr>
<td>Recording Period Enable</td>
</tr>
<tr>
<td>Recording Period Time</td>
</tr>
<tr>
<td><strong>Channel Settings</strong></td>
</tr>
<tr>
<td>Beep</td>
</tr>
<tr>
<td>Monitor</td>
</tr>
<tr>
<td>Trigger</td>
</tr>
<tr>
<td>ROD Mode</td>
</tr>
<tr>
<td>Allow ROD Phone Key</td>
</tr>
<tr>
<td><strong>Network Settings</strong></td>
</tr>
<tr>
<td>IP Address</td>
</tr>
<tr>
<td>Netmask</td>
</tr>
<tr>
<td>Gateway</td>
</tr>
<tr>
<td>Max Session</td>
</tr>
<tr>
<td>Session Duration</td>
</tr>
<tr>
<td>Port Base</td>
</tr>
<tr>
<td><strong>Maintenance</strong></td>
</tr>
<tr>
<td>Recorder ID</td>
</tr>
</tbody>
</table>
7.2.3 Options Menu
The Options Menu is used for system configuration, system maintenance and system shutdown.

7.2.4 Search Menu
The Search Menu is used to set search parameters and to search the database or an archived DVD or CD for a call to replay. Calls found through the search can be tagged for archiving. The Search Menu is used to manually archive select calls to DVD or CD.
7.2.5 Logging Menu
The Logging Menu is the default Menu and is used to view current call data, call activity, call status and play back selected calls. Calls can be tagged and Live Monitoring of calls is enabled from the Logging Menu.

8. Configuring Total Recall

Configuration options for Total Recall are accessed through the Options Menu. To access this menu press the <MENU> key twice from the Logging Menu. The Options Menu contains seven sub-menu items: General, Channel, Archive, Call, Network Settings, System Maintenance, and System Shutdown. If the Options Menu does not appear, you will need to log in as Administrator (see Section 8.2.2).

[Diagram of Options Menu]

Use the <UP> <DOWN> arrow keys to move between the Menus, then <SELECT> to enter a Menu.
8.1 Channel Settings

These settings are configured from the Options Menu (Channel Settings button).

Each channel can be individually configured and managed. If all channels are to be configured identically, configure the first channel and select Apply All.

Use the <DOWN> arrow key to highlight Channel 1 and then the <SELECT> key to bring up the Channel Configuration window. Then use the <UP> <DOWN> arrow keys to scroll through each setting and the <SELECT> key to change the options in each box. When finished, highlight the Apply or Cancel and <SELECT> to confirm the settings or to return to the Channel Settings Menu. Press <MENU> to highlight either OK or Cancel and <SELECT> to return to the Options Menu.

8.1.1 Trigger

This is the setting that starts a recording on a Channel. The trigger can be VOX, 1 through 6 (voice or audio signal), Off-Hook (a voltage level trigger from a phone line) or Off.

VOX 6: High signal and low sensitivity (-20dBm). VOX 6 would pick up “loud” conversations, but may not pick up very soft conversations.

VOX 4: The default setting is VOX 4 (-28dBm).

VOX 1: Low signal and high sensitivity (-40dBm). VOX 1 would pick up a very soft voice, but may also trigger the recorder from a noisy line.

Off-Hook: This is the recommended setting for normal recording from a telephone line. If you are recording telephone calls, we recommend that the “Trigger” settings for each channel remain at the default during the initial configuration set-up.

The Off-Hook function is triggered by a voltage change on the line. A drop in voltage (taking the receiver off-hook – Off Hook voltage is typically 8VDC) will normally provide sufficient voltage change to be detected by the recorder, and activate recording. Replacing the receiver would normally stop the recording (On Hook voltage is typically 48VDC). However, if there is insufficient voltage on the line, the Off-Hook function will not work, and therefore a VOX trigger will need to be selected.

Handset/headset adapters (logger patch) provide audio from the hand piece of a telephone, not a DC voltage, so Off-Hook cannot be used when the recording is via Handset/Logger Patch adapters.

Note: If a channel is set to Off-Hook and no phone line is connected to the channel, the channel will commence recording and can only be disabled by setting the channel to OFF or VOX.

Off: No recording is possible from a channel that has been set to Off. It is recommended that all unused channels be set to Off.
8.1.2 Monitor
This enables Live Monitoring of calls on a channel. By setting a channel Mon (monitor) to On, calls can be live monitored on that channel through the Logging Menu. Options are: On or Off with the default setting being On.

Press the <SELECT> key to toggle between the two settings.

8.1.3 Beep
Beep tone is a “beep” (Pip Tone) sound generated every 15 seconds indicating to both parties that the call is being recorded.

In some countries, it is mandatory to issue a “beep tone” when recording. For some users, it is a matter of preference or company policy. It is possible to turn the “beep tone” On or Off. Total Recall does not transmit a recorded message to advise that recording is taking place. The “beep tone” option can only be used when recording directly from a phone line.

The options are Hi, Mid, Low or OFF. The default setting is OFF.

Press <SELECT> to toggle between the four settings.

Repeat the selection settings for each channel. If all channels are to be configured identically then configure any channel and select Apply All.

8.1.4 ROD Mode (Record On Demand)
ROD Mode settings are used in conjunction with the optional Record on Demand software. They control how users of the Record on Demand will interface with the Total Recall unit. The options are Record by Default, Don’t Record by Default, Record Partial Calls, Add Notes Only or Disallowed. Press Select to toggle between the five settings.

For more information regarding the TR ROD taskbar software and the appropriate channel setup for your application, see the Record on Demand section of this manual. If Record on Demand is not to be used, it is advisable to leave the ROD settings as “Record by Default”.

8.1.5 Allow ROD Phone Key
Alternatively, users can access Record on Demand features by entering a pre-selected DTMF code on their phone keypad. To activate this feature, select the “Allow ROD Phone Key” check box. This will then open a field where you can customize a two-digit DTMF code for keeping or discarding a current call, depending on your ROD Mode settings (See section 11.5 of this manual for further detail).

Users can choose to keep or discard a current call, or stop and start a recording (dependant on the ROD Mode settings) by pressing *, then their code on the phone keypad while a call is in progress.

Note: This function will not work if DTMF tones are not transmitted by your PBX hand set.
8.2 Passwords
This setting is configured from the Options Menu (General Settings Menu).

Total Recall has two password levels (Administrator and User) for enhanced system security. Both passwords have a default setting of 0000.

8.2.1 User Password
After 120 seconds of inactivity, the padlock icon on the LCD will display locked status. Enter the Password to gain access to the three Menus (provided the Administrator Password has not been set (see Section 8.2.2).

8.2.2 Administrator Password
Once the Administrator Password has been set, only the Administrator will have access to the Options Menu and only the Administrator will have the ability to Manually Archive and delete calls to CD or DVD disks. All other functionality (including Manual Archive and retain the calls on the hard drive) will be available with the User Password. If the Administrator Password is not changed from the default setting, all Menus will be accessible with the default (0000) password.

8.2.3 Entering a Password
A password must be entered to access Total Recall’s menus. If Total Recall is left unattended for more than two minutes, or if the “Stop” key (Playback Control Keys) is pressed while not playing a call, the User Interface locks and a password will need to be re-entered to regain access to the menus. The padlock icon at the top right-hand corner of the LCD indicates whether or not Total Recall is secure.
8.2.4 Changing a Password
From the General Settings Menu select the Password button. You can continue to use the default passwords (0000), or new passwords can be set.

Follow the instructions in the sub-menu screen. If you forget your password at any time, the system will be inoperable and you should contact your Total Recall reseller for assistance. It is very important that you do not misplace the Administrator Password. Keep it in a secure place, and a copy in a second secure place. If you lose the Administrator Password, your Total Recall may have to be returned to a factory authorized service facility (or have its hard drive replaced) to have it reset.

Enter your password (8 digits maximum) using the numeric keypad. A null password (just the <SELECT> key) is also possible.

Use the <DOWN> arrow to Confirm New Password.

Enter the same password again to confirm.

Use the <DOWN> arrow to highlight OK or Cancel and <SELECT> to confirm.

Press <MENU> to return to the Options Menu.

8.3 Call Settings
This setting is configured from the Options Menu (Call Settings button).

8.3.1 Minimum Call Length
The Minimum Call Length setting can be between zero and ten seconds in increments of one second, and applies equally to all channels. The call will initially appear in the Logging Menu, but if the call length when the call is terminated is less than the Minimum Call Length setting then the call will be automatically deleted. The default setting is zero meaning that no calls will be deleted.

Extreme care needs to be taken with this setting as it is normal to record all calls and only under very specific circumstances that this setting would be changed from the default (for example - noise spikes external to the recorder causing frequent and unwanted short false recordings).
8.3.2 Maximum Call Length
The Maximum Call Length setting can be between one and sixty minutes in increments of one minute, and applies equally to all channels. If a call reaches the maximum length setting, the call record will be terminated at that point, and then a new record will immediately open. This new record will be indicated by (CONT) after CLI or DTMF digits in the “Number” field. If the “Number” field is full, then the number will be followed by (…) to indicate that there is a continuation of the numbers.

This function enables very lengthy recordings (for example, commercial broadcast radio monitoring) to be presented as a series of recordings in manageable length sizes.

The default Maximum Record Length setting is 60 minutes.

To change the setting press the <UP> or <DOWN> arrow key to highlight the field, press <SELECT> to change the value. Use the <UP> <DOWN> arrows to highlight OK or Cancel to return to the Options Menu.

8.3.3 VOX Timeout
If VOX is set as the recording trigger, VOX Timeout will determine the maximum length of quiet time the recording will continue before being terminated. This ensures that if a call has ended and the phone is not hung up properly, the recorder will not continue to record silence.

VOX Timeout settings can be between 2-15 seconds, and applies to all channels that have the Trigger set to VOX.

In the event that an active call is put on hold, and there is no “music on hold” being played (or music on hold is at a low volume), then the recording will terminate according to the VOX Timeout setting. When the call recommences, the VOX trigger will immediately open and start a new recording so that the complete conversation is captured by creating two or more recordings.

The default VOX Timeout setting is 15 seconds.

**Note:** Whatever the VOX Timeout setting, that length of time must be allowed between the termination of one call and the start of the next call. If the next call starts within the VOX Timeout setting, both calls will appear as one call record on the database, i.e. two calls appear as one continuous call.

To change the setting, press the <UP> or <DOWN> arrow key to highlight the field. Press <SELECT> to change the value. Use the <UP> <DOWN> arrows to highlight OK or Cancel to return to the Options Menu.

8.3.4 Recording Period
**Total Recall** can be programmed to record only between pre-determined times. Press the <UP> arrow key to highlight the Recording Period button. Press <SELECT> to put a check mark in the box. Press the <DOWN> arrow key to access the hour and minutes boxes and either enter numerals with the numeric keypad or press <SELECT> for sequential change. Use the <UP> <DOWN> arrows to highlight OK or Cancel to return to the Options Menu.

With Recording Period activated, the screen below is displayed in the absence of recording.

```
Not Recording
Currently only recording from 12:30 - 19:00
```

OK
8.4 Remote Access Settings

*Total Recall* has two ports for remote access. Com Port ‘A’ for connection to a modem and a ‘LAN’ port for network connection.

![Remote Access Ports](image.png)

**Desktop Unit**

8.5 Network Settings

8.5.1 Connecting *Total Recall* Using LAN

All devices connected to a LAN will need to have a unique IP address. An IP address should be assigned by your network administrator and should be in the same range as the PC’s connecting to *Total Recall*. *Total Recall* is provided with a crossover cable to allow direct connection to a PC without the need for a network switch/hub, which allows for a single PC to connect to a single *Total Recall*. To connect multiple PC’s to *Total Recall* or to connect *Total Recall* to an office LAN you need to connect through a network switch/hub and standard network cables.
8.5.2 Entering IP Address

_Total Recall_ requires an IP address to connect either to a network or direct to a PC using the crossover cable. Enter a unique IP address for the _Total Recall_ to be connected to your network by using the <UP> <DOWN> arrow keys to highlight the first 3 digits in _IP Address_ and using the _Total Recall_ numeric keypad to enter the IP address. To move to the next three digits in the address use the <UP> <DOWN> arrow keys. Scroll down to the _OK_ button to save the new IP address. An IP address should be set only by the System Administrator.

**Note:** _Total Recall_ is shipped with no IP address and it will need to be set to allow operation on your network.

**Caution:** For security reasons it is NOT recommended that dial-up access is activated while _Total Recall_ is connected to your TCP/IP Network.

8.6 Dial-up

8.6.1 Modem

To connect _Total Recall_ via dial-up you will require a serial modem (V90 or V92) and the Modem cable supplied with _Total Recall_: Follow the instructions that come with the modem to connect it to the telephone line and power.

8.6.2 Dial-up Address

There is no requirement to set an IP address when connecting _Total Recall_ to a modem as _Total Recall_ will automatically assign the dial-up IP address to 10.0.1.205.

For instructions about connecting to _Total Recall_ via dial-up, please refer to the Remote Manager section of this manual.

8.6.3 Cascading

The cascade function is used when you wish to connect multiple _Total Recall_ units together and access them via dial-up using a single telephone line.

To use the cascade function you will need to connect the first unit to the modem using the dial-up instructions above. Multiple units can be cascaded to this unit by connecting between the Network Connections on the _Total Recall_ units. A crossover cable can be used if one cascade unit is used. If multiple units need to be connected using cascade, then a network switch/hub will be required. A dedicated network switch/hub should be used when connecting Cascaded _Total Recalls_ together and should never be connected to the office network.

An IP address will be required for each unit to be cascaded. The IP address will need to be set manually and will need to be in the range 10.0.1.1 to 10.0.1.203 or 10.0.1.206 to 10.0.1.254.

8.6.4 DHCP (Dynamic Host Configuration Protocol)

If your network is configured for DHCP, selecting this setting will allow your network to choose an IP address for your _Total Recall_. Use the <UP> <DOWN> arrow keys to highlight _DHCP_ and press the <SELECT> key. This will gray out the IP address section and place a check mark in the box. Scroll down to the _OK_ button and press <SELECT>. The IP address that is allocated for _Total Recall_ will be displayed in the grayed out section of the Network Settings Menu.

8.7 Maximum Sessions

Maximum (Max) Sessions is used in conjunction with Remote Manager and is the maximum number of users allowed to simultaneously monitor or playback calls from a remote location. The default setting is 5. Please consult your IT Manager before changing this setting as increasing this could affect your LAN bandwidth. To change this setting, use the <UP> <DOWN> arrow keys to highlight _Max Sessions_ entry box. Then, using the numeric keypad enter the desired number, scroll to _OK_ and press the <SELECT> key. _Total Recall_ calls are compressed to approximately 1kb per second and use FTP to stream calls to the PC so as to minimize the bandwidth used.
8.8 Session Duration
Session Duration is used in conjunction with Remote Manager and allows for automatic logout of users that are inactive for more than the entered time. Users that are logged out by session duration will be automatically logged back on as soon as there is activity again and Sessions available (see 8.7). Please consult your IT Manager before changing this setting. To change this setting, use the <UP> <DOWN> arrow keys to highlight the Session Duration entry box. Then, using the numeric keypad, enter the desired number in seconds. Scroll to OK and press the <SELECT> key.

8.9 RMI Port
This is used to change the port that Total Recall Remote Manager will open for communications. The default setting is the recommended setting. It is advised that you consult your IT Manager before changing this setting.

8.10 Language
This setting is configured from the Options Menu (General Settings button).
From the General Settings Menu select Language. English, Spanish, Korean, Portuguese, Chinese, Japanese and Arabic languages are available. Use the <DOWN> arrow key to highlight the desired language and press <SELECT> key.

![Change the Language]

8.11 Time & Date
This setting is configured from the Options Menu (General Settings button).
From the General Settings Menu select the Time & Date button.

![Time & Date Settings]
Use the <DOWN> arrow key to highlight the day and key in the day from the numeric keypad or use <SELECT> to sequentially change value. Press the <DOWN> arrow key to highlight the month and use <SELECT> to sequentially change the month. Press the <DOWN> arrow key to highlight the year and key in the year from the numeric keypad or use <SELECT> to sequentially change the value.

Press the <DOWN> arrow key to highlight the hours and key in the hours using 24-hour time from the numeric keypad or use <SELECT> to sequentially change the value. Minutes and seconds are set in the same manner.

Press the <DOWN> arrow key to highlight the Time Zone Area and <SELECT> to choose the appropriate option. Press the <DOWN> arrow key to highlight the Time Zone City and <SELECT> to choose the appropriate option.

**Caution:** Time Zone must be set prior to recording calls. If there are calls on the database these need to be removed prior to setting the time zone. The time zone is saved as part of the call information and may be used by **Remote Manager** to determine the correction required to show the local time of the call if the call is replayed in a different time zone.

Press the <DOWN> arrow key to highlight OK, then <SELECT> to save and exit. **Cancel** aborts and returns to the **General Settings** Menu.

### 8.12 Upgrade Software

This procedure is accessed from the **Options Menu (Maintenance, System Information button)**.

![System Maintenance Options](image)

System upgrades are provided on CD, and uploaded to **Total Recall** from this Menu. System upgrades will change only the **Total Recall** system files.

Insert the upgrade CD into the CD/DVD drive. From the **System Information Screen** select **Upgrade**.

After the upgrade it will be necessary to shut down and restart **Total Recall**. See note below.

**Note Rack Model:** If the Rack Model is mounted in a 19” Rack and the On/Off switch on the Power Supply is not accessible at the rear of the enclosure use the Key switch on the front panel to restart the unit. For location of the Key Switch see Diagram on page 11.

**Note:** Any pre-recorded voice files on the hard drive will not be affected by a software upgrade; however, it is highly recommended to make a complete archive copy of all important calls before starting the upgrade process.

### 8.13 Recorder ID

This feature is accessed from the **Options Menu (Maintenance button)**.

For **Total Recall** installations using multiple recorders, it is often useful to be able to identify from which recorder a particular call originated. The Recorder ID feature permits this identification. Highlight the **System Information** button, press <SELECT> and use the <UP> arrow key to place the cursor over the Recorder ID field. Using the numeric keypad, type in a unique ID for the recorder (up to 3 digits). The Recorder ID is stored in the ‘LogInfo.ini’ file that is saved with every session. When archived calls are being searched on a PC using **Remote Manager**, the Recorder ID can be displayed for each call in the **Remote Manager** Window.
8.14 Rebuild Call Database
This procedure is accessed from the Options Menu (Maintenance button).

In the event of a power outage, line disconnection or other event that may have damaged a call record, or left a call record un-terminated, the system will automatically perform a Database Rebuild.

There is an option to rebuild the call database manually. Select Rebuild Call Database using the <DOWN> arrow key and highlight either Cancel or Rebuild Now and press <SELECT>. Rebuild Now will automatically rebuild the database. After the rebuild, the OK button will be highlighted. Press <SELECT> to return to the Options Menu.

Note: Call recording is suspended while rebuilding the database. Database rebuild may be a lengthy process.

8.15 Save & Load Settings from DVD or CD
This procedure is accessed from the Options Menu (Maintenance button).

After configuring Total Recall, it is recommended that you keep a copy of the configuration on DVD or CD. To save the configuration, place a blank disk into the Total Recall DVD/CD drive and using the <DOWN> arrow key highlight the Save Settings to DVD/CD. Press the <SELECT> key.

This procedure is accessed from the Options Menu (Maintenance button). To load the settings from the disk, place the disk with your previously saved settings into the recorder’s CD drive and using the <DOWN> arrow key highlight the Load Settings From DVD/CD and press the <SELECT> Key.

8.16 Erase DVD
This procedure requires logging in with the administrator password and is accessed from the Options Menu (Maintenance button).

Insert the DVD to be erased into the Total Recall DVD/CD drive and use the <DOWN> arrow key to highlight the Erase DVD button and press the <SELECT> key. Please note that all calls on the DVD will be lost after the erase operation has been performed.

9. Operating Total Recall

9.1 Searching for Calls
These operations are accessed from the Search Menu (Search button).

9.1.1 Searching from the Hard Drive
Highlight the `Search` button using the `<UP> <DOWN>` arrow keys and press `<SELECT>`. This will take you to the `Add Calls to List` Menu. Use the `<UP> <DOWN>` arrow to navigate to each option. Key in the selection from the numeric keypad or use `<SELECT>` to sequentially change the value. Highlight `Search` and press `<SELECT>`. *Total Recall* then searches through the call database on the HDD for all calls that match your search criteria. The more search criteria entered the more specific the result. The date and time of the first and last calls are displayed.

![Search Menu](image)

**Note:** If your search spans 24:00 hours (midnight), the system will not accept time criteria in the search parameters. Either do not specify time criteria, or initially search up to 23:59 hours on Day 1 and then search from 00:00 hours on Day 2.

If the call you are looking for is not found, you may need to check and possibly modify the selection criteria and search again.

9.1.2 Searching from DVD or CD Archive (Using Total Recall)

If you need to locate calls on a previously archived DVD or CD, insert the disk in the drive mechanism. Highlight the `Search` button using the `<UP> <DOWN>` arrow keys and press `<SELECT>`. This will take you to the `Add Calls to List` Menu. Use the `<UP> <DOWN>` arrow to navigate to each option. Key in the selection from the numeric keypad or use `<SELECT>` to sequentially change the value. Highlight `Search DVD/CD` and press `<SELECT>`. *Total Recall* then searches through the archived sessions for all calls that match your search criteria. The date and time of the first and last calls on the disk is displayed.

If the call you are looking for is not found, you may need to check and possibly modify the selection criteria and search again.

The `Tag All` button is not available when working from an archive DVD or CD.
9.2 Replaying Calls

9.2.1 From Search Menu
Selected calls are displayed in the lower part of the Search Menu. The information displayed on each call includes Date, Time, Duration, Number, Channel and Status. The <UP> <DOWN> arrow keys can be used to scroll through the displayed calls. To replay a call, position the highlight bar over the target and press <SELECT>.

Adjust the playback volume by using the volume control thumb wheel on the front panel.

To stop replay, press <SELECT> again, or push the Stop button on the Control Keys.

Alternatively, a call may be replayed using the Playback Control Keys (see Section 5.3.7).

When a call is being replayed, the progress of the call will be displayed at the bottom of the LCD.

9.2.2 From Logging Menu

![LOGGING MENU](image)

To replay a call from the Logging Menu, position the highlight bar over the target call and press <SELECT>.

Adjust the playback volume by using the volume control thumb wheel on the front panel.

To stop replay, press <SELECT> again, or push the Stop button on the Control Keys.

Alternatively, a call may be replayed using the Playback Control Keys (see Section 5.3.7).

When a call is being replayed, the progress of the call will be displayed at the bottom of the LCD.

9.3 Live Monitoring of Calls

This feature is accessed from the Options Menu (Line button). See Section 8.1.2 to enable the Live Monitoring function.

A current call will have the letter (C) in the “Status Column”. Highlight the call with the <UP> <DOWN> arrow keys and then press <SELECT>. The letter (M) in the status column after the (C) will indicate Live Monitoring. If the “beep tone” is enabled, it will be heard on the internal speaker.

To end monitoring, press <SELECT> again. This will stop Live Monitoring, but will not terminate the call.
9.4 Archiving Calls

**Total Recall** stores compressed call files internally on the hard disk drive. Call files can then be archived to DVD+RW or CD-R either manually (whenever required) or automatically (at scheduled intervals). Depending on the call lengths and the number of sessions used, a DVD+RW disk will hold approximately 1,000 channel hours and a CD-R will hold approximately 180 channel hours. It is recommended that calls be archived on a regular basis (see 9.4.1). Call recording will continue during the archive process even though the process may take some time to complete (especially if there are long files or a very large number of files to be archived). Progress will be displayed on the screen. Other recorder functions (other than recording) are disabled during this process.

**Note:** During the archive process, the clock (top right corner) may stop at times. This is part of the normal operation. The screen refresh of the clock functions as a lower priority during the archive.

9.4.1 Archive Sessions

Archiving to a DVD or CD is performed in sessions. Each session updates the disk’s directory, writes the calls and closes with an end of session marker. Archiving to disk media needs to be done thoughtfully as each session marker takes approximately 10Mbyte of disk space. This is equivalent to approximately three hours of calls. Therefore, to minimize wasted space, it is better to archive many hours worth of calls in one session instead of a small number of short calls in multiple sessions.

To maintain compatibility with various CD readers a maximum of 25 sessions is permissible per CD.

9.4.2 Tagging (*) a Call

Calls can be selected for Manual Archiving by placing a Tag (*) in the “Status” column in either the **Logging Menu** or the **Search Menu**. Alternatively, a selection of calls can be Tagged or Un-tagged using the **Tag All/Un-tag All** button within the **Search Menu**.

To Tag a selected call within the **Logging Menu** or **Search Menu**, highlight the call and press the asterisk key (*) on the numeric keypad. To Un-tag a selected call, place the highlight bar over the call and press the asterisk key (*) on the numeric keypad.

Once a selection of calls has been found through the **Search Menu** the whole selection can be Tagged or Un-tagged by highlighting the **Tag All/Un-tag All** button and pressing <SELECT>.

9.4.3 Manual Archiving

This operation is performed from the **Search Menu (Archive button)**.

You first need to select the calls to be manually archived. These calls may have been previously Tagged at the **Logging Menu**, selectively Tagged at the **Search Menu** or a complete list selected (**Tag All** button) from the **Search Menu** call list.

---

**Total Recall** User Manual V4.56-Rev. 4 USA

35
Use the <UP> <DOWN> arrow keys to highlight *Archive Calls*. Press <SELECT> to choose between All Calls, Found Calls, Unarchived Calls or Tagged Calls. When an archive option is selected, *Total Recall* displays the following:

- The number of calls.
- The call size in MB.

Start the archive process by pressing *OK* or *Cancel* to return to the *Search Menu*. If you choose to continue with the archive process and you have Administrator Access (Section 8.2) you will be asked whether you wish to remove the selected calls on the hard drive after the archive has been completed or whether you wish to keep them. Make your selection using the <UP> <DOWN> arrow keys and the <SELECT> key. Alternatively choose to *Cancel* the archive. If you choose to continue with the archive process and you do not have Administrator Access you will not be given the option to remove the selected calls on the hard drive after the archive has been completed. Once the archive process begins, messages will be displayed indicating the status of the archive process. This is followed by a message indicating the completion of the archive.

**Note:** It is recommended to start the archive process during a quiet time, or after hours.

### 9.4.4 Automatic Archiving

This operation is performed from the *Options Menu* (*Archive Settings* button).

To set the *Total Recall* to automatically archive, navigate to the *Auto Archive* button with the <UP> <DOWN> arrow keys and press the <SELECT> key to put a check mark (✓) in the Auto Archive box. The archive time interval is now available to be set. This interval can be set in days or weeks. Press the <DOWN> arrow key to activate the number-options box and use the <SELECT> key to cycle through the options. Press the <DOWN> arrow key again to activate the weeks-days options box and press the <SELECT> key to cycle through the options and make your selection.
Within this screen, *Total Recall* indicates when the next Automatic Archive session will occur based on the present time and the selected time interval. After setting up the Automatic Archive parameters, the first archive will always occur at the following midnight and then the Automatic Archive interval setting will regulate the frequency of subsequent Automatic Archives.

### 9.4.5 Damaged DVD/CD or Insufficient Space

If there is insufficient space on the DVD or CD to accommodate the archive selection, you will be asked to insert a new DVD+RW or CD-R.

If the DVD or CD is damaged in any way, a message will advise that the archive failed and to try again with a different disk.

### 9.4.6 Archive Reminder

This feature is accessed from the Options Menu (Archive Settings button).

To set the Archive Reminder feature, navigate to the Reminder button with the <UP> arrow key and press the <SELECT> key to put a check mark in the Reminder box. Use the <DOWN> arrow key and <SELECT> key to set the Reminder at either 50%, 75% or 90% hard drive capacity. This is a visual reminder of actual disk space used. This message will continue to appear even after an automatic archive as no calls have been removed from the recorders hard drive.

### 9.5 Deleting Calls

*Total Recall* has been designed as a secure recording system. It is not possible to enter any of the User Menus and delete selected files from the database. However, there are two ways in which files can be removed from the database:

a) Delete using the “Do you want to remove the calls you archive?” selection from the Manual Archive procedure (Section 9.4.3) when you are logged in as an Administrator.

b) Auto system deletion. This is an automatic system function, designed to ensure that *Total Recall* does not stop recording when the hard drive reaches maximum capacity. If at any time the hard drive usage reaches 100% of the specified capacity at midnight on any day, the oldest calls are automatically deleted until the hard drive data folder content is reduced to 80%. During this process, the system will continue to record calls.

### 9.6 System Shutdown

This procedure is accessed from the Options Menu (System Shutdown button).

Because *Total Recall* uses a database with active and open files, *Total Recall must be properly shut down before the power is turned off*. *Total Recall* should always be shut down using the System Shutdown Menu within the Options Menu.

In the Options Menu, press the <UP> arrow key until the System ShutDown button is highlighted. Press the <SELECT> key then highlight the OK in the confirmation box and press <SELECT>. Wait until you see a blank screen before switching off.

### 10. Remote Manager Software

#### 10.1 Introduction

*Remote Manager* is client software for *Total Recall*. *Remote Manager* is Windows compatible software that together with LAN or Dial-up connection enables all the functions of *Total Recall* to be executed from the convenience of your office via a PC. Calls from one or multiple *Total Recall* units, connected via either the LAN or a dial-up connection using a modem can be searched, replayed, live monitored,
tagged, notated and emailed. Recorded calls can also be transferred from Total Recall to the PC either by “drag and drop” to a local folder or from archive DVD/CD. Remote Manager allows for the remote configuration of all connected Total Recall units from your PC, including optional Record on Demand settings. Remote Manager enables those users who do not wish to connect Total Recall to their LAN or a Dial-up to replay calls from their archive media (CD/DVD).

10.2 PC System Requirements
Remote Manager software is designed for use on a multimedia PC running Windows 98/ME/2000/NT4 or XP. Total Recall calls that are archived onto the DVD or CD are stored in a compressed and encrypted data format that cannot be played on a multimedia PC without using Remote Manager software. The recordings can be converted (de-encrypted) into .wav or .mp3 files using Remote Manager software.

Minimum system requirements:
- 100MB free HDD space
- 128MB RAM
- Display resolution 800x600, 256 colors
- Sound device and speakers
- LAN device or modem

10.3 Installation
Loading Remote Manager Software onto your PC.

Remote Manager software is supplied on a CD together with the Total Recall unit. To install, insert the CD into the PC drive and follow the instructions on the screen.

If the install does not start, manually select “SETUP” from the disk.

Please check with your System Administrator prior to installing Remote Manager.

10.4 Configuring Total Recall for LAN or Dial-up
Please refer to (Section 8.5 and 8.6)

10.5 Add Total Recall (for Remote Access from a PC)
Please ensure that you have the IP address or dial-up number and the password (PIN) before continuing to add a Total Recall to Remote Manager.

To add a Total Recall click on the Add New Total Recall icon, which will bring up the Add TR window.
10.5.1 LAN
Click the LAN tab to access the LAN IP Address entry box. Type in the unique LAN IP address of the Total Recall to be added, followed by the Total Recall PIN and a description. The PIN is the same as the Total Recall password and will give the user the same access rights as if the password was typed into the Total Recall unit. The description is a name that will identify the Total Recall unit to the user.

Clicking on the Set button will start the process of searching for and adding the Total Recall to the Remote Manager system.

Repeat this process to add more units.

10.5.2 Host Name
Consult your Administrator prior to using the Host Name feature. If you are unsure about the host name operation, it is suggested that you use the function described in the previous section.

The host name feature allows the Total Recall to be referred to by an alphanumeric name rather than an IP Address. Many people find this easier to remember. A service called DNS or Domain Name Service provides the mapping between this alphanumeric name and the IP address of the Total Recall. The network administrator will need to update the DNS to provide this mapping (or at least update the HOSTS file on the client machine).

10.5.3 Remote Manager Firewall
This setting is only necessary when Remote Manager is behind a firewall, on an internal IP address, and the Total Recall needs to access the Remote Manager through that external firewall IP address. In this case the external address of the firewall should be entered in this field. An example is shown below.
See section 10.18 “When Remote Manager is behind a local firewall” for more information.

10.5.4 Dial-up

Click the Dial-up tab to access the Dial-up entry box. Type in the number to be dialed to access the remote Total Recall, followed by the Total Recall PIN and a description. The PIN is the same as the Total Recall password and will give the user the same access rights as if the password was typed into the Total Recall unit. The description is a name that will identify the Total Recall unit to the user.

Clicking on the Set button will start the process of searching for and adding the Total Recall to the Remote Manager system. Please note that this will dial the number specified, as Remote Manager needs to contact the Total Recall to complete this process.

Repeat this process to add more units.

10.5.5 Cascaded (Connecting Multiple Total Recall Units)

The cascade function is used when you wish to connect multiple Total Recall units together and access them via dial-up using a single telephone line.

Click the Dial-up tab to access the Dial-up entry box. Choose the dial-up host (this will be a Total Recall connected to dial-up) and the IP address of the cascaded unit followed by the Total Recall PIN and a description. The PIN is the same as the Total Recall password and will give the user the same access rights as if the password was typed into the Total Recall unit. The description is a name that will identify the Total Recall unit to the user.

Clicking on the Set button will start the process of searching for and adding the Total Recall to the Remote Manager system. Please note that this will dial the number specified, as Remote Manager needs to contact the Total Recall to complete this process.

Repeat this process to add more units.

10.5.6 Authorized Channels

The authorized channels section allows the administrator to restrict the channels of the Total Recall that the user will see when searching for calls. To modify which channels the user is authorized to see in a search, click the Modify button next to the Authorized Channels bar.
Clicking *Set All* will select all channels as authorized for control by the *Remote Manager* user. *Clear All* will deselect all channels, meaning the user has no authorization to replay calls or modify settings. Channels may be designated authorized or unauthorized individually by clicking the check box next to the appropriate channel. A check mark in the box means that the channel is authorized, whereas a blank box means that the channel is unauthorized. By default, all channels are authorized.

### 10.6 Connection Using *Remote Manager*

To connect to a unit using *Remote Manager*, either by LAN or dial-up, click on its icon in the tree. If connection is via dial-up, the number will automatically be dialed. When the connection is completed, the icon will change to show that the connection is complete. If the connection is via LAN there is no change of icon. After connection, *Remote Manager* will operate the same for LAN or Dial-up.

### 10.7 Configuration

*Remote Manager* will allow full configuration of each *Total Recall* unit that has been added to your *Remote Manager* system where you have administrator rights. All parameters that can be set using the *Remote Manager* configuration are saved to the *Total Recall* unit. To begin configuring a *Total Recall*, click on the TR Configuration TAB and the *Total Recall* you wish to configure.

#### 10.7.1 Channel Configuration

Each channel is separately configurable. Click the + sign next to the *Total Recall* description and this will drop down the channels available for configuration.
Using the drop down boxes in the configuration window will allow you to configure the trigger level, tone insertion, channel description and **Record on Demand** settings. Clicking on the Enable Monitoring check box will toggle if the channel can be monitored. Click on Apply before moving on to the next channel to save channel settings to the **Total Recall** unit.

Multiple channels can be configured simultaneously by highlighting the required channels. Change the channel configuration as previously explained. Clicking on the Apply button will save the same configuration to all channels. To highlight all channels, click on the first channel to be configured, then, while holding the shift key, click on the last channel to be configured.

### 10.7.2 Archive
The archive tab will allow you to set automatic archive, archive device and archive reminder parameters. To change the archive period, click in the text entry box and type your selection using your keyboard. To change the archive period, choose your selection from the drop down box using your mouse. Click the Apply button to save this configuration to **Total Recall**.

### 10.7.3 General
The general settings tab allows you to change the Administrator Password, User Password, Recorder ID, VOX Timeout, Minimum and Maximum Recording Length and the Recording Period.
10.7.4 Passwords
A password is required to access functions of Total Recall. You must have administrator access to change passwords. To change the password of the Total Recall unit, click on the key icon in the General Settings Tab and enter the new password into the field provided. You will be required to confirm the password. Please ensure that you keep the passwords in a secure location.

10.7.5 Recorder ID
The recorder ID should be set as a unique three-digit number that is used to identify the Total Recall unit. To change this setting, simply click in the Text entry box and type your selection.

10.7.6 VOX Timeout
If VOX (audio activated recording) is set as the recording trigger, VOX Timeout will determine the maximum length of quiet time the recording will continue before being terminated. This ensures that if a call has ended and the phone is not hung up properly, the recorder will not continue to record silence.

VOX Timeout settings can be between 2-15 seconds, and applies to all channels that have the Trigger set to VOX.

In the event that an active call is put on hold, and there is no “music on hold” being played, the recording will terminate according to the VOX Timeout setting. When the call recommences, the VOX trigger will immediately open and start a new recording so that the complete conversation is captured across two recordings.

The default VOX Timeout setting is 15 seconds.

To change this setting, click in the text entry box and type your selection.

Note: Whatever the VOX Timeout setting, that length of time must be allowed between the termination of one call and the start of the next call. If the next call starts within the VOX Timeout setting, both calls will appear as one call record on the database, i.e. two calls appear as one continuous call.

10.7.7 Minimum Recording Time
The Minimum Call Length setting can be between zero and ten seconds in increments of one second, and applies equally to all channels. The call will initially appear in the Logging Menu on the Total Recall being configured, but if the call length is less than the Minimum Call Length setting then the call will be automatically deleted. The default setting is zero meaning that no calls will be deleted. Extreme care needs to be taken with this setting as it is normal to record all calls and only under very specific circumstances (for example, noise spikes external to the recorder causing frequent and unwanted false recordings) that this setting would be changed from the default.

10.7.8 Maximum Recording Length
The Maximum Call Length setting can be between one and sixty minutes in increments of one minute, and applies equally to all channels on the Total Recall being configured. If a call reaches the maximum length setting, the call record will be terminated at that point, and then a new record will immediately open. This new record will be indicated by the word “Continued” in the “Number” field. If the “Number” field has DTMF digits displayed, then the number will be followed by (....) to indicate the call is a continuation.

This function enables very lengthy recordings (for example, commercial broadcast radio monitoring) to be presented as a series of recordings in manageable length sizes.

The default Maximum Record Length setting is 60 minutes.

10.7.9 Recording Period
Total Recall can be programmed to record only between predetermined times.

With Recording Period activated and if the time is outside the selected times, the following screen is displayed on the Total Recall in the absence of recording.
10.8 Record on Demand (ROD) Agents

ROD agents are user accounts for the Total Recall Record on Demand software. A user cannot log in to a Total Recall unit with TR ROD until a user account has been set up in Remote Manager. The ROD Agent list is stored on the Total Recall unit, hence only users with administrator access may add or modify ROD agents.

10.8.1 Adding ROD Agents

To add a new agent, click the Add Agent button in the ROD Agents menu. A new menu will appear, prompting the user to add an Agent Name and Password. These should be unique for every user of the TR ROD software. The language displayed by TR ROD for each user may also be configured in this menu. To save the new ROD agent settings, click OK in the Add Agents menu, followed by Apply in the ROD Agents menu. You must click Apply before any changes will take effect.

10.8.2 Other ROD Settings

In the ROD Agents menu, the administrator has the option to:

Remove individual agents from the Total Recall ROD Agent list, by highlighting an agent and clicking the Remove Agent button, followed by clicking the Apply button.

Remove all agents from the Total Recall ROD agent list, by clicking the Remove All button, followed by clicking the Apply button. If no agents are configured on the Total Recall unit, then TR ROD will not be able to connect to it.

Change the password for an individual agent, by highlighting the user to be modified, and clicking the Change Password button. A new menu will appear where the new password may be entered and confirmed. This change may be saved by clicking OK in the new password menu, followed by clicking Apply in the ROD Agents menu.

Change the display language for an individual agent, by highlighting the user to be modified and clicking the Change Language button. A new menu will appear with a drop-down list of available languages. Select the desired language and click OK in the change language menu, followed by Apply in the ROD Agents menu.
10.8.3 Allow ROD Phone Key
Alternatively, users can access Record on Demand features by entering a pre-selected DTMF code on their phone keypad. To activate this feature, select the “Allow ROD Phone Key” check box. This will then open a field where you can customize a two-digit DTMF code for keeping or discarding a current call, depending on your ROD Mode settings (See section 11.5 of this manual for further detail).

Users can choose to keep or discard a current call, or stop and start a recording (dependant on the ROD Mode settings) by pressing *, then their code on the phone keypad while a call is in progress.

10.9 Monitoring

10.9.1 Live Monitoring
Remote Manager has the facility to live monitor channels on all connected Total Recall units where monitoring has been allowed in the configuration. Notes can be added to a monitored call.

To listen to an active channel either select the required channel from the tree to the left hand side of the screen or from the black “Live Monitor” panel at the bottom of the screen.

**Note:** The “Live Monitor” panel will only contain the first 10 configured Total Recalls. To monitor more than 10 Total Recalls you must use the tree.
10.9.2 Channel Status

- Monitoring disabled. Channel cannot be monitored.
- Monitoring is active but there is no activity on the line.
- Live call in progress.
- Monitoring is in progress.
- Channel is unauthorized for the current user.

10.10 Search and Playback Calls Using Archive Media (DVD or CD disk)

10.10.1 Search and Playback Using an Archive Media (CD or DVD)
For those users who do not wish to use the convenience of the LAN or Dial-up functionality of **Total Recall**, you can search and playback calls simply by inserting the archive DVD or CD into the drive on the PC and clicking on the drive icon in the directory tree on **Remote Manager**. All the functions described in this section can then be utilized to help narrow your search.

10.10.2 Searching Calls
You can search and play calls from all **Total Recall** units that have been added to your **Remote Manager** system as well as a DVD/CD Drive or (if calls have been previously saved to a local folder from an archived DVD/CD) from a Local Folder on your hard drive. Calls can be arranged by Date or Channel by clicking on the appropriate selection.

**Sort by Date:** Calls will be arranged in a tree by Date and then by Channel. Clicking on a channel or date will set the criteria in the search options window. Clicking on “Search Now” will display only calls in the calls window relating to the search criteria.

**Sort by Channel:** This will arrange the calls in a similar fashion as Sort by Date except the tree will display the channel first and then the date.
10.10.3 Loading Calls
In the Playback Calls window, click the + button beside the device from which you want to load calls. Click Search Now and the contents of the device will be displayed on the screen. It is then possible to use the search criteria to narrow the search for the desired call.

10.10.4 Searching for Calls
You can search by date, time, channel, phone number, call length, note keyword, call direction or any combination of these parameters. If you want to reduce the number of calls found, simply refine the search criteria, click the Search Now button and the results of the search will be displayed. 1000 calls will be displayed and clicking the more key will display the next 1000.

10.10.5 Search by Date
Click the Date From: icon and highlight the start date for the search. Similarly select the Date To: icon for the end date.
10.10.6 Search by Time
Click the Time Range: icon and move the sliders to define the start and stop time of the search.

10.10.7 Search by Channel
Click on the Channel check box and enter the number of the channel you wish to search in the text entry box.

10.10.8 Search by Phone Number
Click on the Phone Number check box and enter the number or part of the number you wish to search in the text entry box.

10.10.9 Search by Call Length
Click on the Call Length check box. Click the icon and set the Call Length using the sliders. Set the minimum and maximum call length to be searched.

10.10.10 Search by Note Keyword
Click on the Note Keyword check box. Type the keyword.

10.10.11 Search by Call Direction
Click on the Call Direction check box. Use the drop down menu to make your selection.

10.11 Modify Local Folders Window
This window is used to create and modify Local Folders that will be used to store call records. Once a Local Folder is created, the Local Folder will appear in the Playback Calls Window. Calls in the Calls List can be highlighted and dragged into a folder in the Modify Local Folders window for storage on the hard drive.

To create a local folder, simply click on the ICON and create a new folder or select the folder you wish to use to store your calls.

10.12 Replaying a Call
With the call data information loaded on the screen, double click on the call you wish to play or click on the call and then click the play button ⏯️.
Call progress is indicated by a Slider Bar located beneath the call window and the counter shows the exact time of the call. At any time, the call can be paused by clicking the Pause Button \( \ll \) or the call can be stopped by clicking the Stop Button \( \square \). Clicking the Stop Button will reset the Slider Bar back to the beginning of the call. At any time the progress of the call can be moved forward or taken back by placing the cursor on the Slider Bar and dragging it to the left or right. This facility, along with the call counter/timer makes for quick and accurate replay of important parts of a call.

Other control buttons include save the recording \( \square \), add or modify a note about the recording \( \square \) and customize the call table contents \( \square \).

10.13 Save the Recording
To save a single call to your local hard drive, first highlight the call in the Call Play Window and then click the \( \square \) icon. Choose the local folder you wish to save the call to and select whether to save the call as a .trc, .mp3 or as a .wav file.

10.14 Add or Modify a Note
Highlight a call (or a selection of calls) and click the \( \square \) icon. The following screen will be displayed.

![Add note dialog](image)

Type in any notes you require and click OK. When searching for calls, you have the option to search by keywords entered into the call notes.

10.15 Delete Calls
This function is used to delete calls from local folders only. Highlight a call (or selection of calls) that you want deleted and click the \( \square \) icon. You will be asked to confirm that you want to delete the selected call(s). This will not delete calls from a Total Recall or DVD/CD.

10.16 Customizing Call Table Columns
You have the option to customize the information displayed in the Call Table.
Select the *Customize Table Columns* icon and the following screen will appear:

Choose the information you want displayed in the Call Table by placing a check mark in the box beside each option and clicking *OK*. The Call Table will be refreshed with your selected information.

You are able to change the width of a column in the Call Table by placing the cursor between the *column name* buttons and dragging the column to the required width. The position of the columns relative to each other can also be changed. Place the cursor on the *column name* button and drag the whole column to a different position in the table.

### 10.17 Accessing Total Recall Through a Firewall

While it is not possible to describe solutions for all different network setups, it is hoped that from this example, a network administrator will be able to learn how to provide access to a *Total Recall* unit through a firewall.

Consider the following example:

Here *Total Recall* is connected on an internal network with an IP Address range of 192.168.3.x. The *Total Recall* has the address 192.168.3.109. There is a firewall which provides access to the internet. This allows other company servers to be accessed using a Public IP Address in this case 203.10.10.10. The Firewall has the internal address 192.168.3.252.
PC’s on the internal network should be able to access the Total Recall units directly via the LAN. A client would like to be able to connect to the Total Recall over the internet from home.

The network administrator should follow the following steps:

- Configure the Total Recall’s IP Address and set the firewall’s internal address as its gateway.

![Network Setting](image)

- Install Manager on one of the internal network PC’s.
- Add the Total Recall to the manager as shown in the diagram.

![Add TR](image)

- Use the internal manager application to modify the Total Recall’s host name as shown in the diagram below.

⚠️ **Note:** To connect to the TR externally through firewalls you must connect using a host name rather than just using an IP Address. Remote Managers on the internal network can connect using IP address rather than host name.
Note: { As a small aside at this point the system administrator could add the Total Recall’s IP Address into the internal DNS server so that Remote Manager clients running on the internal network could access Total Recall using the name totalrecall1 instead of having to remember the IP address. However that is not necessary for our particular example. }

- Configure the Firewall by forwarding the following ports:

Forward port 10010, & 10011 to the Total Recall’s address 192.168.3.109 (‘10010’ is the configured Port Base in our example).

Note that this is a TCP connection.

In addition, if you want to transfer files to your local folders or email files from the Total Recall, you will need to port forward FTP (port 21) to this address as well:

- Tom’s machine must be able to resolve the name totalrecall1 to the Firewalls externally visible IP Address.

One simple way to do this is to edit the hosts file… EG: On windows 2000 or windows XP modify the file C:\WINNT\system32\drivers\etc\hosts to contain the line

203.10.10.10 totalrecall1

You can ensure that this is correct by typing: “ping totalrecall1” at a command prompt.

- Install Remote Manager on Tom’s home machine.

- Add the Total Recall making sure you use the hostname not the IP Address as shown in the following diagram:
Tom’s home **Remote Manager** should now be able to access the **Total Recall** on the internal company network.

### 10.18 When **Remote Manager** is Behind a Local Firewall

In the previous example the client’s **Remote Manager** was on an externally visible IP address. In this case the **Remote Manager** is on an internal IP address, trying to access a **Total Recall** which is external to the LAN.

An example of this situation is shown in the picture below:

In this case you will need to:

- Port forward UDP from port 10001 to the IP address of the machine running **Remote Manager**.
- Port forward UDP from port 10002 to the IP address of the machine running **Remote Manager**.
- In addition, when you add the **Total Recall** to **Remote Manager**, you will need to specify the external IP address of the firewall that it is sitting behind. Check the “Manager Firewall” check box and enter the IP address in the appropriate fields to the right of the checkbox.
You should now be able to connect to the Total Recall.

10.19 Handling Multiple Remote Managers Behind a Local Firewall
The situation is similar to that discussed in section 10.18 except that there are now 2 Remote Managers that need to access the Total Recall behind the same local firewall.
The first *Remote Manager* can be set up exactly as for section 10.18 i.e.:
1. Port forward UDP from port 10001 to the IP address of the machine running *Remote Manager*.
2. Port forward UDP from port 10002 to the IP address of the machine running *Remote Manager*.
3. Specify the Manager Firewall when adding the *Total Recall*.

For the second *Remote Manager* you need to tell it to use different ports and then forward these ports from the firewall. In the diagram the second *Remote Manager* is configured to use ports 10005, 10006. These ports are then port forwarded from the firewall as UDP.

Configure the second *Remote Manager* to use the different ports by accessing “Advanced…” from the File Menu. Then enter the port in the Manager Port Base field as shown below:

![Advanced Settings](image)

The manager will now be using 10005 and 10006 (i.e.: one higher than the configured base ports).

In this way multiple *Remote Managers* can access the *Total Recall* through the same remote firewall.

### 10.20 Connecting Through a VPN

A VPN allows all machines to appear as though they are on the same LAN segment, even though some may be accessed over the internet. This usually makes the configuration of *Total Recall* and *Remote Manager* simple.

One case which can complicate the situation is if the machine on which you are running *Remote Manager* has 2 IP addresses. By default, *Remote Manager* will use the first IP address. If this is incorrect you can modify *Remote Manager* to use the alternative IP address. To do this, select “Advanced…” from the file menu, then enter the desired local IP address for *Remote Manager* in the dialog.

![Advanced Settings](image)

### 10.21 Limitations of *Total Recall* & *Remote Manager* with Firewalls

#### 10.21.1 Transfer of Files

Transfer of files is currently done using the FTP protocol on its default port. If two *Total Recalls* are behind the same firewall, it will not be possible to port forward FTP to both machines. The user will only be able to transfer files from the *Total Recall* which has FTP port forwarded to it.

#### 10.21.2 Alternatives

Where these limitations are unacceptable we suggest that you move to a VPN, or some sort of screen sharing technology to achieve your desired result (such as Microsoft’s Remote Desktop Connection).
10.22  Monitoring & Playback — Audio not Working
I don’t hear any sound when I attempt to remotely monitor or remotely playback a call from Remote Manager, however, I can playback a call from Remote Manager on a local CD or in a local folder.

NOTE: This procedure should only be used after consultation with the network administrator for your network. The following steps are written for Windows XP. They will need to be modified for other operating system versions.

Case 1 RESOLUTION
- I can't play back a call on Remote Manager, it happens only on Windows XP.
- Make sure that there is no check mark in the Don't allow exceptions box on the XP Windows Firewall setting.

![Windows Firewall screenshot](image)

Case 2 RESOLUTION
STEP 1: Run dos command prompt and type the command “ipconfig”

![Command Prompt screenshot](image)
STEP 2: For **Remote Manager** to work correctly there should be one and only one IP address. If there are two IP addresses, monitoring and playback will not work correctly. The diagram below shows the situation where two IP addresses are configured:

![Command Prompt]

STEP 3: If two IP addresses are shown (as in the diagram above), then you need to remove one of the IP addresses in the following way:

Run Network connections by going Start->All Programs->Accessories->Communications->Network Connections as shown in the diagram below.

![Network Connections]
STEP 4: Double click on Local Area Connection to bring up the following dialog box:

[Image of Local Area Connection Status dialog box showing connected status and activity details]

STEP 5: Click the Properties button to give the following dialog box:

[Image of Local Area Connection Properties dialog box with various options and settings]

Total Recall User Manual V4.56-Rev. 4 USA
**STEP 6:** Select Internet Protocol (TCP/IP) and press the properties button to bring up the following dialog box:

![Internet Protocol (TCP/IP) Properties dialog box]

**STEP 7:** Press the advanced button to bring up the following dialog box:

![Advanced TCP/IP Settings dialog box]

**STEP 8:** Select the unwanted IP Address and press the remove button. The remaining IP address should be an IP Address, which is on the same network as the *Total Recall*. For example, if the *Total Recall* is configured as 192.168.3.39 then use 192.168.3.38 as the main IP address for the PC. If in doubt which one to remove talk to your network administrator.

Press *OK*… and check that the PC only has one IP Address configured. This can be done by running “ipconfig” in the command prompt as described in steps 1 and 2 of this document.

NB: Only one IP Address is shown.

Confirm that remote monitoring and playback now work by running *Remote Manager*. 
11. Record on Demand Software

11.1 Introduction

Record on Demand is an optional license free software application that provides additional real-time functionality to Total Recall end users. Utilizing an existing LAN connection, users can start and stop recording of a current call, control what calls on their line are recorded or not recorded, as well as have the ability to add notes to a current call (all controlled from a simple taskbar application on the user’s PC).

If a user requires Record on Demand without immediate access to a PC, this function can also be controlled through pre-determined codes entered on a user’s phone. This is configured on the Total Recall unit itself or in Remote Manager. (See sections 8.1.4 and 10.7.1 of the manual for further details on the DTMF Record on Demand function.)

To ensure the security of the Total Recall, Network administrators have the flexibility to tailor the users level of control with Record on Demand through specific unit settings, or through their Remote Manager software. (These options are discussed in section 12.6 of this manual).

11.2 PC Requirements

Record on Demand is designed for use on a multimedia PC running Windows 98/ME/2000/NT 4.0 or XP.

Minimum system requirements:

- 100MB Free Hard Disk space
- 128MB RAM
- Display resolution 800*600, 256 colors
- LAN connection

11.3 Installation

Insert the TR ROD installation CD into the user’s PC. The installation wizard will auto run if the computer is configured to allow this. If this is not the case, run Setup.exe from your configured CD drive.

During installation, you will be given the option to:

- Install TR ROD to a folder other than the default
- Change the default location to store user files
- Alter the program name displayed in the Control Panel
- Create a desktop icon

Default settings should be sufficient for most users.

11.4 Running TR ROD for the First Time

11.4.1 Connecting to the Total Recall Unit

Total Recall IP Address refers to the unique network address of the Total Recall unit. This address may be accessed from the “Network” menu on the Total Recall unit itself, or from the “TR Configuration” menu in your Remote Manager software. (Note: Remote Manager should be setup and operational before installing TR ROD, as TR ROD Agents are added and managed through this software). If in doubt, contact your network administrator.

Total Recall Channel refers to the channel of the Total Recall unit that you wish to give the user limited control over. This is generally the channel that the user has connected to their phone. TR ROD allows an agent limited control over one channel only.

Total Recall Password can either be the User or Administrator password for the Total Recall unit. Either password may be used to alter TR ROD configurations, so it is important that the Total Recall unit passwords (User or Admin) are not given to agents if they are not authorized to alter settings.
**Total Recall Port Base** refers to the port used to access the **Total Recall** unit. The port base, like the unit IP address, may be accessed from the “Network” menu in **Total Recall**, or the “TR Configuration” menu in **Remote Manager**. If in doubt, contact your network administrator.

### 11.4.2 Logging into TR ROD

In the “Agent Name” drop down menu, the user should select their login name. (N.B. agent login names and passwords are added using the “Remote Manager” software. Agents must be added before TR ROD can be utilized. This may only be done through Remote Manager). **Remote Manager** should only be installed and configured on secure PC’s operated by individuals who are authorized to monitor, search and play back calls.

For security, all users should have an individual login.

After selecting the appropriate login name and clicking “Login”, the user will be prompted for their password. This will be the individual password nominated when setting up the ROD agent account in **Remote Manager**. (See Remote Manager Section for more information).

### 11.5 Using TR ROD — TR Unit Settings

**Record on Demand** settings may be modified for individual channels on the **Total Recall** unit (via the Channel Settings menu), or via **Remote Manager** (from the TR Configuration tab).

These unit settings affect the way that the recorder will respond to the **Record on Demand** software, or activation of the DTMF phone key.

There are 5 channel options for **Record on Demand**:

<table>
<thead>
<tr>
<th>Channel</th>
<th>Trigger</th>
<th>Monitor</th>
<th>Beep</th>
<th>ROD</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Record by Default</td>
</tr>
<tr>
<td>2</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Don’t Record by Default</td>
</tr>
<tr>
<td>3</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Add Notes Only</td>
</tr>
<tr>
<td>4</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Disallowed</td>
</tr>
<tr>
<td>5</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Record by Default</td>
</tr>
<tr>
<td>6</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Record by Default</td>
</tr>
<tr>
<td>7</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Record by Default</td>
</tr>
<tr>
<td>8</td>
<td>VOX 4</td>
<td>On</td>
<td>Off</td>
<td>Record by Default</td>
</tr>
</tbody>
</table>

#### 11.5.1 Record by Default

**Total Recall** will record all calls unless the TR ROD user intervenes.

#### 11.5.2 Don’t Record by Default

The TR ROD user will be given the option to only record a current call if they so wish. The **Total Recall** unit will not record calls unless the TR ROD user intervenes.

#### 11.5.3 Add Notes Only

The user with the TR ROD agent installed may only add notes to a current call – they will have no control over whether a call is recorded or not.

#### 11.5.4 Record Partial Calls

In this instance, the **Total Recall** machine does not record calls by default. A user can start and stop recording during the call as many times as they wish. The only sections of the call that are recorded are the periods where a user has activated the recorder.
11.5.5 Disallowed
The TR ROD agent will have no effect on that particular channel. TR ROD users cannot add notes, nor will any control be given to retain or discard current calls. The Total Recall unit will record according to its VOX/Off Hook channel settings.

11.6 Login, Logout and Refresh
Login needs to be selected after a user chooses their individual Agent name. Following this a window will appear prompting the user to enter their password in order to utilize TR ROD. For security, users have to re-login after any TR ROD configuration changes, or after changes to the channel settings on the Total Recall unit.

Logout should be selected to finish a user’s session. For security, it is recommended that users log out of TR ROD if they are not present at their PC, to prevent unauthorized control over the Total Recall channel. Users need to logout to allow another user to log back in with a different agent name and password.

Refresh may be used if new agents have been added through Remote Manager while TR ROD is running. Selecting Refresh will update the agent list to the most current record stored on the Total Recall unit.

11.6.1 Configuration
Similar to the connection process when TR ROD was first installed, this menu allows authorized personnel to do the following:

Total Recall IP Address refers to the unique network address of the Total Recall unit. This address may be accessed from the “Network” menu on the Total Recall unit itself, or from the “TR Configuration” menu in your Remote Manager software. (Note: Remote Manager should be operational on the network manager’s computer before installing or changing TR ROD, as Agent names and passwords are managed through this software).

Should the IP address of the target Total Recall unit be altered, the TR ROD agent will need to be re-configured (via this menu) in order to re-connect to the unit. This cannot be changed without a valid password (see below).

Total Recall Channel refers to the channel of the Total Recall unit that you wish to give the agent limited control over. The channel controlled may be changed in this menu, dependant on a valid password being given (see below).

Total Recall Password can either be the User or Administrator password for the Total Recall unit. One of these passwords must be entered correctly in order to change any TR ROD settings. Either password may be used to alter the TR ROD configuration, so it is important that the unit passwords (User or Admin) are not given to users if they are not authorized to alter settings.

Total Recall Port Base refers to the port used to access the Total Recall unit. The port base, like the unit IP address, may be accessed from the “Network” menu in Total Recall, or the “Network” menu in Remote Manager. If in doubt, contact your network administrator.

12. Preventative Maintenance

Total Recall needs regular maintenance to ensure its performance is maintained. As with any computing device, Total Recall has a fan that provides airflow across the processor to keep it cool and a filter to ensure that the air is clean. Every 3 months a message will appear on the Total Recall screen to indicate that filter maintenance is required. The filter will need to be washed in warm soapy water and then rinsed thoroughly and allowed to dry completely prior to being replaced. New filters are available from your supplier (package of 3 is item # TR-FIL). After maintenance is complete, select OK to remove the message.
13. Trouble-shooting Tips

a) There is a loud and continuous tone sounded when using the control keys.
   The soft key may be stuck against the casing. Just move the key to release it.

b) The unit does not power-up.
   It is possible that the fuse holder may have become loose during transit or the fuse is blown.
   Disconnect the power cord, remove the fuse holder at the rear of the unit and check that the fuse is OK.
   Power-up again.

c) The password has been forgotten.
   Call your dealer for support.

d) I have changed the password and now it will not let me go to the Options Menu.
   You have changed the User Password. The User has no access to the Options Menu. Use the
   Administrator Password to provide access to the Administrator level Options Menu. If you do not
   know the Administrator Password, you will not have access to the Options Menu.

e) The recorder is switched on with channel lines connected. The Logging Menu shows “C” in
   the status column and the LEN (Length) meter is running, but no calls are active.
   The channels are probably set to Off-Hook. Enter the Options Menu and change the Line Trigger setting from Off-Hook to VOX 4.

f) During the process of recording a call, the call appears to be cut into multiple records, each
   of a fixed length.
   Check the Maximum call length setting in the Options Menu (Call button). If a call reaches the
   maximum length setting, it will be cut and then restarted as a new (continuation) record, with no
   loss of recording between the cut and restart. To avoid cutting the call into multiple records,
   increase the Maximum call length setting.

g) During the process of recording a call, the call appears to be cut into multiple records, each
   of a varied length.
   Check the VOX level settings of the channel(s) concerned. It is possible that the VOX level
   threshold is too sensitive in detecting silence on the line. For example, “VOX ” detects a high
   signal with associated low sensitivity, so if the voice at either end is not loud enough or is not
   talking continuously, the recorder may detect a period of silence and cut the call. At the same
   time, check the VOX Timeout setting in the Options Menu. If the VOX level threshold is too
   low, the calls will be cut based on the VOX Timeout setting. A combination of changing the
   Trigger setting and increasing the VOX Timeout setting should eliminate the problem of cut calls.

h) The call I am replaying finishes in the middle of the call, and I know that there was an extended conversation.
   This call has most likely been “cut” as determined by the Maximum call length setting. Check the
   channel number of the call in the Search Menu, then search for the next call at the same channel
   number and you will find the remainder of the call. The second part of the call should be
   indicated by a (cont...) entry in the number field that indicates a continued call.

i) When making a telephone call, I can hear the remote party very clearly but when I play back the call, it is hard to hear the remote party.
   This is associated with the AGC (Auto Gain Control) built into the recorder. The recorder is
designed to “record” all the sounds heard on the line, both Transmit (Tx) and Receive (Rx). This
includes background noise, line noise and ambient noise. The recorder “records all audio noise”,
and cannot distinguish between “background” and “foreground” noise. This problem may be
compounded if the recording is made via Handset Adapters. In this case, the “background noise”
fed back through the microphone of the handset is combined with the Receive (Rx) signal from
the “Remote Party”, and therefore what appears to be a clear voice to the listener may sound soft
or hard to hear upon replay. This is a function of the AGC which “averages out” all of the audio
signals detected during the recording. If on the other hand there is no background noise, the
“Remote Party” will sound very clear and loud upon replay.

j) I am dialing a number and I can hear the tones on my phone, but no DTMF number
appears in the Logging Menu next to the (C) Current Call.
If recording via a handset adapter, it may not be possible for the recorder to detect DTMF tones.
If your phone system transmits a proprietary signal to the PABX, and the PABX converts this
signal to DTMF tones, then the recorder cannot detect the DTMF as it is not present at the point
of recording. The recorder will detect DTMF tones, provided they are on the line at the point of
recording.

k) I have selected Archive and now my keyboard has locked-up and the recorder does not seem
to be working.
The archive process takes time. Writing to a DVD or CD is a time-consuming process. During
the archive process, the <MENU> and <SELECT> keys will be disabled and you will have no
access to other functions of the recorder. DO NOT SWITCH OFF THE POWER. Although you
have no access to the recorder, it will still be recording on active channels, and it will still be
archiving calls to the disk. It is recommended to start the archive process during times of low-
usage, or when you do not need to gain further access to the recorder for a period of time.

l) I have archived calls to a DVD or CD but the “% Used” indicator on the Logging Menu
remains at the same level.
The Archive “Do you want to remove the calls you archive?” option (only available with
Administrator Access) will archive calls to a disk and either delete them from the hard drive (Yes)
or keep them on the hard drive (No). If you choose to keep the archived calls on the hard drive,
the “% Used” indicator will not change. If you choose to delete the archived calls from the hard
drive, the “% Used” indicator will decrease after archiving.

m) I’m trying to set the IP Address of the Total Recall but pressing the OK brings up the error
message “Update Network Settings Failed”.
Chances are the IP address that you are trying to use is already used by some other computer or
device. You will need to find an IP address that isn’t used by asking your Network Administrator.
The best way to check if an IP address is used is to logon to a PC that is on the network. Then try
pinging the IP address. Do this by starting a command shell and typing “ping <IPADDRESS>”
where <IPADDRESS> is something like 192.168.3.10. If something responds, that IP address is
in use.

n) When I try to play, save or email a searched call, I get a message saying “You are not
authorized for this channel”.
The channel that the call originated on has been disallowed for your user account. This can be
altered by clicking User Preferences, then Properties, followed by the TR Connectivity tab, then
Properties. The Authorized Channels menu is at the base of the Modify Total Recall Settings
menu. Note that only an Administrator account can access these menus.
14. Specifications

**Number of Channels:** Desktop: 4, 8, 12 or 16. Rack Mount: 4, 8, 12, 16, 20, 24, 28, or 32. (Channel upgrades are available in 4 or 8 channel increments)

**Security:** Password (2 levels)

**Coding Method:** 8kbps High Quality Vector Quantization providing over 10,000 hours of on-line recordings database.

**Line Impedance:**
- (Aus & USA) 6 K ohm
- (NZ) 12 K ohm
- (EUR) 67 K ohm
- (DC) 60 M ohm

**Line Impedance:**
- (Aus /NZ/Europe) 1M ohm
- (USA) 10M ohm

**Frequency Response:** 300-3400 Hz, +/- 0.5dBm.

**Signal to Noise:** -34dBm.

**Cross-talk:** -60dBm.

**Record (PIP) Tone:** 1.4kHz. Channel and Level selectable. (Off, -33dBm, -27dBm, -21dBm)

**Recording Triggers:** Off-Hook, VOX (adjustable), OFF

VOX 6, -20dBm; VOX 5, -24dBm; VOX 4, -28dBm;
VOX 3, -32dBm; VOX 2, -36dBm; VOX 1, -40dBm

**Internal Storage:** Hard Disk Drive.

**DVD or CD Drive:** DVD Drive uses CD-R or DVD+RW Media

**Display:** 130mm x 97mm, 5¼" x 3¾" color TFT backlit LCD

**Power Requirements:**
- Tip to Ring: 250VDC
- Tip to Ring: 150VAC rms
- Tip to Ground: 1500VDC
- Tip to Ground: 1000VAC rms

**Analogue Ports:** 4, 8, 12, 16, 20, 24, 28 or 32

- RJ11C/RJ12/RJ14 (PSTN) line interface ports.
- 4-channel DSP interface uses pins 3 & 4
- 8-channel DSP interface uses pins 3 & 4 plus 2 & 5
- Line Out Jack (3.5mm stereo)
- Headphone Jack (3.5mm stereo)
- 57Kbps, Hardware Handshake

**Client Software:** Remote Manager & TR Record On Demand

(Windows 95/98/NT/ME/2000/XP)

**System Software:** Field upgradeable via CD Media

**Operating System:** Linux Fedora Core 2

**Size and Weight:**
- Desktop: 365 x 375 x 165 mm, 6kg net
  14½" x 14¼" x 6½", 13 lb net
- Rack Mount: 480 x 230 x 220 mm (5U), 10kg net
  19"x 9"x 8½", 22 lb net

**Enclosure:**
- Desktop: UL 94V-0 ABS plastic
- Rack Mount: Standard EIA 19" Rack configuration (5U)
  Zinc Passivated steel with Powder-Coated face panel.

*Specifications subject to change without notice.*
15. Appendix A, Glossary of Terms

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>PABX/PBX</td>
<td>Private Automatic Branch Exchange/Private Branch Exchange.</td>
</tr>
<tr>
<td>MDF</td>
<td>Distribution Frame, normally used in a communications room to distribute and patch cabling.</td>
</tr>
<tr>
<td>DTMF</td>
<td>Dual Tone Multi Frequency.</td>
</tr>
<tr>
<td>Extension Side</td>
<td>Normally referred to as the office side, station side or handset side of the PABX.</td>
</tr>
<tr>
<td>Trunk</td>
<td>Incoming telephone lines, either analogue or digital.</td>
</tr>
<tr>
<td>Telephone</td>
<td>The base of the desktop phone equipment and cradle for the hand-piece.</td>
</tr>
<tr>
<td>Handset/Handpiece</td>
<td>Hand-held assembly that includes microphone (mouthpiece) and speaker (earpiece).</td>
</tr>
<tr>
<td>Handset Adapter</td>
<td>A device to tap the audio signal from the handpiece of a telephone handset. Also referred to as a Handset Patch, or Logger Patch or Handset Splitter.</td>
</tr>
<tr>
<td>Beep Tone</td>
<td>A tone that sounds every 15 seconds to alert that the call is being recorded.</td>
</tr>
<tr>
<td>CLI/CLIP</td>
<td>Caller Line Identification, Caller ID, or Caller Line Identification Presentation.</td>
</tr>
<tr>
<td>Status Line</td>
<td>Information line displayed at the bottom of each of the User Menus.</td>
</tr>
<tr>
<td>UPS</td>
<td>Uninterruptible Power Supply.</td>
</tr>
<tr>
<td>DSP</td>
<td>Digital Signal Processor.</td>
</tr>
</tbody>
</table>

16. Appendix B, LCD Screen Messages

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>The date the call was placed or received.</td>
</tr>
<tr>
<td>Time</td>
<td>The start time of the call.</td>
</tr>
<tr>
<td>Length</td>
<td>The length or duration of the call, in seconds.</td>
</tr>
<tr>
<td>Number</td>
<td>The inbound or outbound call number.</td>
</tr>
<tr>
<td>&gt; &lt;</td>
<td>The direction of the call is displayed, if either CLI or DTMF has been captured.</td>
</tr>
<tr>
<td>Channel #</td>
<td>The channel number associated with the call.</td>
</tr>
<tr>
<td>Status (ST)</td>
<td>The status of the call (see below).</td>
</tr>
</tbody>
</table>

The possible messages in the status column are as follows:

* = The call is tagged.
C = The call is current (i.e. it is happening at this time).
X = The call has been damaged.
A = The call has been archived.
M = Monitoring this live call.

If a call is being replayed, the status column will indicate the following:

> = Playing
>> = Fast Forward
>>> = Skipping Forward
<< = Rewinding
|| = Paused
17. Software License Agreement

ARUNTA SOFTWARE LICENCE AGREEMENT

End-User Licence Agreement for Arunta Software – Total Recall, Remote Manager & Record on Demand.

IMPORTANT - READ CAREFULLY:
This Arunta Software Licence Agreement (“ASLA”) is a legal agreement between you (either an individual or a single entity) and Arunta Comsec Pty Ltd for the Arunta software product identified above, which includes computer software and associated media and printed materials, and may include “online” or electronic documentation (“SOFTWARE PRODUCT” or “SOFTWARE”). By installing, copying, or otherwise using the SOFTWARE PRODUCT, you agree to be bound by the terms of this ASLA. If you do not agree to the terms of this ASLA, promptly return the unused SOFTWARE PRODUCT to the place from which you obtained it.

SOFTWARE PRODUCT LICENCE
The SOFTWARE PRODUCT is protected by copyright laws and international copyright treaties, as well as other intellectual property laws and treaties. The SOFTWARE PRODUCT is licensed, not sold.

GRANT OF LICENCE
This ASLA grants you the following rights:
The software and hardware described in this document are furnished under a licence agreement and may be used only in accordance with the terms of the agreement. The software that accompanies all Arunta products is the property of Arunta Comsec Pty Ltd (ABN 40 051 658 569), and is protected by copyright law. While Arunta continues to own the software, you will have certain limited rights to use the software after your acceptance of this licence. Except as may be modified by a license addendum which accompanies this licence, your rights and obligations with respect to the use of this software are as follows:

DESCRIPTION OF OTHER RIGHTS AND LIMITATIONS
Limitations on Reverse Engineering, Decompilation, and Disassembly: You may not reverse engineer, decompile, or disassemble the SOFTWARE PRODUCT, except and only to the extent that such activity is expressly permitted by applicable law notwithstanding this limitation.
Termination: Without prejudice to any other rights, Arunta may terminate this ASLA if you fail to comply with the terms and conditions of this ASLA. In such event, you must destroy all copies of the SOFTWARE PRODUCT and all of its component parts.

UPGRADES
If the SOFTWARE PRODUCT is an upgrade of an Arunta product, you now may use that upgraded product only in accordance with this ASLA.

COPYRIGHT
All titles and copyrights in and to the SOFTWARE PRODUCT (including but not limited to any images, photographs, animations, video, audio, music, text, and “applets,” incorporated into the SOFTWARE PRODUCT), the accompanying printed materials, and any copies of the SOFTWARE PRODUCT, are owned by Arunta or its suppliers. The SOFTWARE PRODUCT is protected by copyright laws and international treaty provisions.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES
To the maximum extent permitted by applicable law, in no event shall Arunta or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use the software product, even if Arunta has been advised of the possibility of such damages.

MISCELLANEOUS
The developer, Arunta Comsec Pty Ltd has adopted a policy to continue the development of Total Recall and Remote Manager and therefore there may be variations between the documentation and the operating system at any one time.
Should you have any questions concerning this ASLA, or if you desire to contact Arunta for any reason, please contact the Arunta reseller serving your country, or write to:

Arunta Comsec Pty Ltd
PO Box 572
Milsons Point, NSW 1565
Australia

Document: Version 4.56, Rev. 4 18 July 2006
TOTAL RECALL

Voice Logging Recorders are distributed in the U.S.A. by:

Omnicron Electronics

581 LIBERTY HIGHWAY ● P.O. BOX 623 ● PUTNAM, CT 06260-0623
☎ (860) 928-0377 ● FAX (860) 928-6477
support@omnicronelectronics.com
www.omnicronelectronics.com